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Introduction 
Sage, a recognized leader in accounting software for mid-size 

businesses, welcomes you to Sage 500 ERP, business software that 

provides superior power, flexibility, and integration with your 

existing line of business applications. 

In this chapter 

About This Guide ...................................................................................................... 2 

Prerequisite Knowledge ......................................................................................... 3 

Sources of Information .......................................................................................... 4 
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About This Guide 
 

 
Overview 

The Getting Started guide provides an introduction to your software, including 

explanations of system components and features and the sources of information 

available to you. 

 

Information provided 

Use this guide to learn the following: 

• Sources of information 

• Basic system components 

• How to log on to the system 

• Common processing elements 

• How to perform basic tasks and navigate the system 

• How to use reporting features 

• How to use the Help system 
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Prerequisite Knowledge 
 

 
Understanding of Windows-based products 

This guide assumes you have a basic understanding of Microsoft Windows. 
 

Sage 500 ERP interfaces with Microsoft Windows-based products, such as Microsoft 

Excel and Microsoft Word, and it is assumed that you have an understanding of 

these products. 

 

Knowledge of basic accounting 

This guide does not attempt to teach accounting, but describes the overall system 

and accounting features of the software; an understanding of accounting concepts is, 

therefore, required. 
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Sources of Information 
 

 
Introduction 

As a user of the software, you have access to many sources of information, both 

printed and online, as well as customer support services. The following tables 

explain the information provided by each of these resources. 

 

Introductory system and setup information 

Introductory and system setup information is provided in the following documents. 

 
Resource Information Provided 

Getting Started 
guide 

• Overview of system components and 
features 

• Sources of information 

• Explanation of common processing 
elements 

• Batch processing 

• Logon procedures 

• Methods of navigation 

• Using the Help system 

• Reporting features 
 

Release Notes Explanation of enhancements and issues 
for the latest release. 
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Configuration and installation 

Installation and system configuration information is provided in the following 

resources. 
 

Resource Information Provided 

Compatibility 
and Resource 
Guide 

 
Installation and 
System 
Configuration 
guide 

 
 
 
 
 

 
Business Insights 
Dashboard guide 

 

• Compatibility information matrices 

• System requirements 

• System configuration 

 
• System requirements 

• Database and client installation 

procedures 

• General installation setup procedures 
for the Business Insights Dashboard 

• System security 

• Software registration 

• Procedures and reports for the 
System Manager module 

 

Site hosting, installation and 
configuration, Web site customization, 
and troubleshooting 

Business Insights Dashboard 
How to install and configure Business 
Insights Dashboard 

 
 

 

User guides 

User guide resources include the following documents. 
 

Resource Information Provided 

Sample Reports 

guide 

This guide provides samples of reports. 
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Module PDFs These guides include the task Help for all 
tasks accessible from the Desktop. For 
more information, see Procedure Help on 
page 134. 

 

 

Software Development Kit (SDK) 

Information on customizing your software is provided in the following documents. 
 

Resource Information Provided 

Software 
Development 
Kit (SDK) 
Developers' 
Guide 

 
 
 

 
Software 
Development 
Kit (SDK) 
Installation 
Guide 

 
 
 
 

Software 
Development 
Kit (SDK) Data 
Integration 
Services Guide 

How to customize modules and develop 

custom applications, including: 

• The programming techniques used to 
support Sage 500 ERP standards 

• Techniques required to customize the 
Help system 

• This guide is available when you 
install the SDK. 

 
• How to install the Application 

Framework or any of the modules' 
source code. 

• Hardware, software, and database 
requirements 

• Using a version control tool 

This guide is available when you install 
the SDK. 

 
• Data Migrator architecture 

• How to use Data Migrator APIs to 
load data on an ongoing basis 

• How to customize migrations 
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Software 
Development 
Kit (SDK) 
Release Notes 

 
 
 
 
 

SDK Reference 
Documents 

• Enhancements 

• Issues 

• How to upgrade from a previous 
release 

• How to use Prestos 

This guide is available when you install 
the SDK. 

The following documents provide 
supporting SDK information: 

• Software Development Kit (SDK) 
Programming Components 

• Software Development Kit (SDK) 
Development Utilities (used to 
maintain system tables) 

• Enter Sales Orders and Quotes 
Customization Procedures 

• Design Documents 

• API Specifications (stored procedures, 
triggers, and tables) 

• Schema Browser (used for reading the 
data model) 

This guide is available when you install 
the SDK. 
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Help system 

The Help system contains the following types of information. For more information, 

see Using the Help System on page 132. 

Resource Information Provided 

Sage 500 ERP 
Help system 

• Overview Help for each task and 
related links 

• Procedural steps for Sage 500 ERP tasks 

• F1 Field-Level Help 

• Access to the Help Center 

• Record layout tables and pre-import 
procedures for importing data into the 
General Ledger, Accounts Receivable, 
Accounts Payable, Inventory 
Management, and Cash Management 
modules 

• Module PDFs that you can print as a 
reference 
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Support 

These resources provide additional support. 

Resource Information Provided 

Sage Customer 
Portal 

Internal research database, which includes: 

• The Sage Knowledgebase for quickly 
locating the information you need 

• Downloads, hot fixes, and numerous 
other support services 

The Support area of the Sage Customer 
Portal provides information on the 
following: 

• Service plans and support topics 

• Installation/configuration  support 

• News groups 

• Support phone numbers and hours 
 

 

 

How to contact Sage 

Sage welcomes your comments and suggestions. Contact us at: 

Sage 

271 17th Street Northwest 

Atlanta, GA 30363 

Phone: (800) 854-3415 

http://www.sage.com 

http://na.sage.com/
http://na.sage.com/
http://na.sage.com/
http://na.sage.com/
http://na.sage.com/
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System Components 
This chapter provides an overview of the products and 

components. 

In this chapter 

Components ............................................................................................................... 11 

Component  Features ........................................................................................... 13 
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Components 
 

The following table shows the components that make up the software. 

 
Component Features 

Base system 
components 

• Desktop 

• System Manager 

• Explorer 

• Common Information 

• Sage 500 ERP Office 

• DataPorter 

• Data Import Manager 

• Sage 500 ERP Alerts 
 

Financials • General Ledger 

• Accounts Payable 

• Accounts Receivable 

• Cash Management 

• Intercompany Transactions 

• National Accounts 

• Credit Card 

Advanced financials • Multicurrency 

Distribution • Sales Order 

• Purchase Order 

• Inventory Management 

• Inventory Replenishment 
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Component Features 

Manufacturing • Light Manufacturing 

• Advanced Manufacturing 

• Shop Floor Control 

• Engineering Change Management 

• Advanced Planning and 
Scheduling 

• Material Requirements Planning 

• Estimating 

• Product Configurator 

Project Accounting • Project Accounting 

Report writers and 
data analysis 

 
 
 

Customization 
tools 

• Crystal Reports 

• Business Insights Analyzer 

• Business Insights Explorer 

• Business Insights Dashboard 

 
• Application Framework 

• Customizer 

• Source Code 
 

 



System Components 

Getting Started 13 

 

 

 

Component Features 
 

 
Overview 

The following tables describe the main features of each component. 
 

For descriptions of associated documentation and additional information resources, 

see Sources of Information on page 4. Complete descriptions of module features and 

integration capabilities are provided in the Help system. 

 

Base system components 

These are the components of the base modules. 

 
Component Features 

Desktop Provides a starting point for all system 
tasks. Use the Desktop to: 

• View menus and launch tasks 

• Change the company 

• Access the Help Center 

• Perform system inquiries with 

Explorer 

For more information, see Using the Sage 
500 ERP Desktop on page 35. 
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Component Features 

System Manager Use System Manager to: 

• Register modules 

• Create companies and security 
groups 

• Define system options, users, and 
passwords 

• Set user preferences 

• Print reports 

• Use Assisted Company Setup to set 
up Sage 500 ERP. It includes the 
data entry and import utilities 
available for each step. 

• Use Data Migration to insert data 
into the system and, if converting 
from a supported Sage 100 ERP, 
extract the data from the old 
system. 

 
Explorer Use Explorer to access system-wide 

inquiries. 

Common 

Information 

 
 
 
 
 
 

Sage 500 ERP 
Office 

Set up and maintain options and 
information that are common to one or 
more modules. This information 
sharing allows you to update data for 
multiple modules automatically from 
one place. 

Information on Common Information 
is provided in the Help system. 

 

Sage 500 ERP Office is a set of utilities 
that allows you to integrate financial 
information with the Microsoft Office 
suite of applications to create 
documents and spreadsheets. Sage 500 
ERP Office takes information from, and 
attaches files to, Sage 500 ERP entities. 
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Component Features 

DataPorter • Move data between spreadsheets 

and Sage 500 ERP forms 

• Bring setup data into the system 
during conversion or load data on 
an ongoing basis 

 

Data Import 
Manager 

 
 
 
 
 
 
 

Sage 500 ERP 
Alerts 

• Import pre-defined data entities 
into Sage 500 ERP databases 

• Import entities supported by the 
Assisted Company Setup (ACS) task 

• Import data from SQL Server, Sage 
100 ERP, XML, comma-delimited, 
text, and Microsoft Access and Excel 
files 

 
• Automatically monitor your system 

for alert conditions and send 
automatic e-mail notification to 
selected recipients 

• Customize alert parameters, e-mail 
notifications, and scheduling 

• Predefined base alerts are defined by 
the system 
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Financials 

These are the financial components. 

 
Component Features 

General Ledger • Set up accounts, account structures, 
fiscal calendars, budgets, financial 
reports, and journals 

• Accept transactions created in other 
applications 

• Enter and post transactions, 
including allocations and recurring 
entries 

• Set up, enter, and post 
intercompany transactions 

• Set up and print financial 

statements 

Accounts Payable • Set up vendors and vendor classes 

• Automate many vendor-related 
tasks 

• Process Accounts Payable - Accounts 
Receivable settlements 

• Enter and post invoices and 
adjustments 

• Select invoices for payment 
automatically 

• Maintain and track detailed invoice 
and check histories for each vendor 

• Print checks 

• Merge two existing vendors into 
one vendor 

 



System Components 

Getting Started 17 

 

 

 
 

Component Features 

Accounts 
Receivable 

 
 
 
 
 
 
 
 
 
 
 
 
 

Cash 
Management 

 
 
 
 
 
 
 
 

 
Intercompany 
Transactions 

• Set up customers, customer classes, 
salespersons, and sales teams 

• Automate many customer-related 
tasks 

• Process invoices, cash receipts, 
finance charges, and commissions 

• Print invoices and statements 

• Set up and maintain national 

accounts 

• Merge two existing customers into 
one customer 

• Consolidate multiple shipments as a 
single invoice from the same sales 
order 

 
• Process bank transactions, generate 

deposits, and reconcile bank 
accounts 

• Determine cash flow projections 

• Integrate with Accounts Receivable 
to generate automatic deposits and 
with Multicurrency to set up bank 
accounts in foreign currencies 

• Integrate with Accounts Payable to 
reconcile checks 

 
• Process transactions between 

companies 
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Component Features 

Credit Card • Set up and configure credit card 

processing behaviors 

• Receive credit card payments in 
sales orders, invoices, and cash 
receipts 

• Capture credit card funds during 
shipment processing 

• Daily credit card transaction 
settlement integrated with Cash 
Management 

• Refund credit card payments 

• Secured storage of credit card 
account data 

 

National 
Accounts 

 
• Maintain national accounts, which 

allow you to group customers into a 
two-level relationship consisting of 
a parent customer and subsidiary 
customers 

 
 

 

Advanced financials 

This is the advanced financial component. 
 

Component Features 

Multicurrency • Manage multiple currencies, 

exchange schedules, and rate 
fluctuations 

• Automatically post realized and 
unrealized gains and losses to 
general ledger accounts assigned 
to the currency 
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Distribution 

These are the distribution components. 

 
Component Features 

Sales Order • Enter sales orders, price quotations, 
and blanket orders 

• Delete sales orders based on security 
settings 

• Automatically update all open order 
lines in a sales order with entry 
made in the order header controls 

• Create pick lists and ship lists 

• Generate invoices, obtain invoice 
totals, and print Accounts 
Receivable invoices prior to 
committing the shipment 

• Process customer and interbranch 
transfer shipments 

• Process customer returns 

• Track sales history 

• Customize the Enter Sales Orders 
and Quotes data entry grid and 
Favorites tab 

 

Purchase Order • Set up buyers, tolerance codes, and 
departments 

• Delete purchase orders based on 
security settings 

• Enter and print requisitions and 
purchase orders 

• Process receipt of goods from 

vendors or other warehouses 

• Process receipt of invoice and 
returns 
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Component Features 

Inventory 
Management 

 
 
 
 
 
 
 
 
 
 
 

 
Inventory 
Replenishment 

• Set up inventory items, item classes, 
buyers, warehouses, kits, and bins 

• Set up pricing structures for 
products and customers 

• Track transaction history and on- 
hand quantities 

• Process physical inventory 

• Process inventory transactions 

• Process customer returns and RMAs 

• Analyze your inventory investment 

• Transfer goods between warehouses 

• Recalculate inventory quantities 

 
• Calculate replenishment parameters 

• Process replenishment orders 
 

 

 

Manufacturing 

These are the manufacturing components. 
 

Component Features 

Light 
Manufacturing 

• Create routings/bills of material 
with backflushing (automatic 
issues) 

• Enter all production information 
on one screen, which backflushes 
all production components 
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Component Features 

Advanced 
Manufacturing 

• Create and track work orders 

• Track outside processor 
transactions and job costs 

• Produce co-products, by-products, 
and disassembly operations 

• Make employee assignments 
 

Shop Floor Control • Log employees on and off jobs 

• Make labor assignments 

• View real-time labor and 
production online 

Engineering 
Change 
Management 

 
 
 

Advanced Planning 

and Scheduling 

 
• Process engineering change 

approvals on routings and work 
orders 

• Notify by e-mail and define 
approval sequence 

 
• Create phantom schedules from 

estimating, work orders, sales 
orders, and manufacturing 
inquiry 

• Run production schedules with 
finite or infinite capacity 

• Automatically schedule and view 
work orders 

• Schedule MRP planned work 
orders 
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Component Features 

Material 
Requirements 
Planning 

• Use system calculations of supply, 
demand and replenishment of 
finished goods, raw materials and 
manufactured components 

• Create planned and actual 
purchase orders for purchased 
items 

• Create planned and actual work 
orders for manufactured items 

Estimating • Produce detailed estimates using 
routing techniques 

• Convert estimates to sales orders 
or customer quotes with sales 
price overrides 

 

Product 
Configurator 

• Create items and routings 

• Create new routings and bills of 
material within the configuration 
definition 
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Project Accounting 

These are the Project Accounting components. 

 
Component Features 

Project Accounting   •  Track actual versus estimated costs 
through forecast completion 

• Monitor project details, including 
estimates, change orders, purchase 
orders, timesheets, and billing 

• Select from multiple project types 

• Choose from six GAAP-compliant 
profit recognition methods 

• Seamlessly integrates with the 
Accounts Payable, Accounts 
Receivable, Purchase Order, and 
Inventory Management modules 
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Report writers and data analysis 

These are the report writer and viewer tools. 

 
Component Features 

Crystal Reports • Use standard, preconfigured 
reports, choosing detailed or 
summary information 

• Customize reports with a 
configurable, user-friendly report 
customizer 

• Create bar graph and pie chart 
reports 

• E-mail reports for efficient 
distribution 

• Export report data to multiple 
formats, including Word, Excel, 
ASCII, and dBase 

• Create and modify business forms 
such as checks, invoices, and 
statements 

 

Business Insights 
Analyzer 

 
 
 
 
 
 
 

 
Business Insights 
Explorer 

• Display data in a Data Grid, pivot 
table, or chart 

• Refine data sets using filter tools 

• Port data to the Crystal Report 
Wizard 

• Export data to Microsoft Excel, 
Microsoft Word, PDF, or 
eXtensible Markup Language 
(XML) 

 
• Navigate through data 

• View related data 

• Refine and save customized data 
sets using filters 

• Group or subtotal data 
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Business Insights 
Dashboard 

This browser-based application allows 
you to consolidate information and 
instantly view critical business data. 

• Create a personalized view of Sage 
500 ERP data, including sales, 
product, and customer analyses 

• View e-mail, calendars, and 
contacts 

• View company intranet and 
Internet Web sites 

 
 

 
 

Customization  tools 

These are the customization tools. 
 

Component Features 

Application 
Framework 

• Build custom applications with 
the same look and feel as Sage 500 
ERP 

• Work with Visual Basic controls, 
wizards, and utilities to solve 
housekeeping issues, including 
concurrency, user interface, 
security model, and data handling 

• Work with information on the 
database structure and an 
interactive data schema viewer 
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Customizer Enables you to customize window 
interfaces and functionality by: 

• Adding industry-specific features 
without making changes to source 
code 

• Customizing text and fields that 
appear on forms and changing 
form layout 

• Adding new fields to forms and 
new buttons to the toolbar using 
scripts 

• Adding VBScript and Java Script 
programming logic to any form 
developed with the Sage 500 ERP 
framework 
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Starting Sage 500 ERP 
This chapter provides the procedures for logging on to your software, 

including the use of authentication options. Additionally, you will 

learn how to use the Client Configuration Utility to change your 

logon settings. 

In this chapter 

Logging On ................................................................................................................. 28 

Authentication Options ..................................................................................... 29 

Using the Client Configuration Utility ................................................... 32 

3 
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Logging On 
 

 
Procedure 

After you obtain a user name and password from your system administrator, start 

Sage 500 ERP. You can log on by doing either of the following: 

• From the Windows Start menu, select Sage 500 ERP Desktop. 

• Right-click the Sage icon in the Windows System Tray and select Login into 
Sage 500 ERP Desktop. 

• Either method opens the logon window. 
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Authentication Options 
 

 
Introduction 

The first time you log on to the software, you must select the type of authentication 

you use for logging on. Your system administrator should be able to provide this 

information. The authentication type you use determines how you log on, as 

described below. 

 

Option types 

Use the following table to determine the authentication type to use. 

 
To use... Do this... To get this result... 

SQL Server 
authentication 

 
 

 
Windows 
authentication 

Clear the Use 
Windows 
Authentication 
check box. 

 

Select the Use 
Windows 
Authentication 
check box. 

Each time you start the 
software, you are 
prompted for a logon 
name and password on 
the logon window. 

 

Your Windows user name 
and password are used to 
log on. The first time you 
start the software, the 
logon window appears, so 
that you can select the 
server, databases, and 
company. After that, the 
software starts directly 
and uses the last server, 
databases, and company 
you selected. 
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Access rights 

For information on granting access rights for Windows authentication, refer to the 

Installation and System Configuration guide. 

 

Logging on with SQL Server authentication 

To log on to the software for the first time with SQL Server authentication, complete 

the logon window as follows: 

1 Clear the Use Windows Authentication check box (if it is not already cleared). 

2 At the User Name field, enter your SQL Server user name. 

3 At the Password field, enter your password. (Passwords are required only if 

specified in System Manager Set Up Options. For more information, refer to the 

Installation and System Configuration guide.) 

4 Select the Advanced Options check box if it is not already selected. This 

expands the logon window with fields for selecting the server and databases. 

5 Verify that the server and database fields indicate the server and system and 

application databases you want to use. To change the server and database 

fields, select the Change Server/Database check box. This enables the server 

and database fields and allows you to make your selections. 

If you do not see the server or database selections you want, click Refresh. This 

lists the SQL Servers in the domain and the databases in the selected SQL Server. 

6 At the Company field, select the company to use. 

7 To log on to the same server and database each time you start the software, 

select the Save Setting As Default check box. 

8 Click OK to log on. The Sage 500 ERP Desktop appears. For more information, 

see Using the Sage 500 ERP Desktop on page 35. 
 

The next time you start the software, you will be prompted again for your user name 

and password. 
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Logging on with Windows authentication 

If you are logging on to the software for the first time and you have access rights to 

use Windows authentication, complete the logon window as follows: 

1 Select the Use Windows Authentication check box. This disables the User 

Name and Password fields. 

2 Select the Advanced Options check box and the Change Server/Database check 

box. This enables the fields for selecting the server and databases you want. If 

the options you want do not appear, click Refresh to update the options. 

3 Click OK to log on. The Sage 500 ERP Desktop appears. For more information, 

see Using the Sage 500 ERP Desktop on page 35. 
 

The next time you start the software, the logon window will not appear. The 

program starts directly using the server and database you last used. 
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Using the Client Configuration Utility 
 

 
Introduction 

Use the Client Configuration Utility to change logon and other Windows Registry 

settings used by the client software. Use this program instead of changing registry 

settings manually. 

 

When to use 

Situations for using the Client Configuration Utility include: 

• Changing logon options when using Windows authentication. When you are 
using Windows authentication, the logon window does not appear after the 
first time you log on. The Client Configuration Utility enables you to change 
to another server and databases, log on as a different user, or change to SQL 
Server authentication. 

• Resolving logon issues. If you get errors when you try to start the software, it 
may not have been configured to log on to a valid SQL Server and database. 
Use the Client Configuration Utility to select a SQL Server and database and try 
logging on again. 

• Turning off the startup logo. This reduces network traffic when you use 
Windows Terminal Server. 

• Viewing the paths of program and Help files. 
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How to use 

Before starting the Client Configuration Utility, shut down Sage 500 ERP. Select 
Windows Start menu > All Programs > Sage > Sage 500 ERP 2023 > Utilities > Client 
Configuration Utility. The Client Configuration Utility window appears. 

 

 
 

Procedure 

Complete the window as follows: 

1 Select whether to configure settings for all Windows users or only for the user 

that is currently logged on. 

2 Select the SQL Server and database to use. If you do not see the server or 

database options you want, click Refresh. This lists the SQL Servers in the 

domain and the databases on the selected SQL Server. 

3 To log on with the user's Windows logon, select the Use Windows 

Authentication check box. When the user starts the software, that person's 

Windows logon is used, along with the rights assigned to it. To prompt for a 

logon name and password, clear this check box. Users can then log on using a 

SQL Server logon name and password. 

4 To prevent the startup logo from appearing each time you start the software, 

clear the Show Startup Logo check box. Select the check box to display the logo 

each time. 
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Common Navigation 
Features 
This chapter begins by explaining the Sage 500 ERP Desktop: the 

starting point for the entire system. You then learn to navigate 

the software using the common system and processing elements. 

In this chapter 
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Common Menus .................................................................................................... 51 
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Dates ............................................................................................................................... 91 
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Using the Sage 500 ERP Desktop 
 

 
Purpose 

When you log on to Sage 500 ERP, the Sage 500 ERP Desktop appears. The Desktop 

provides a starting point for all system tasks and enables you to do the following: 

• Navigate through installed modules and their menus 

• Launch Sage 500 ERP tasks 

• Add and launch non-Sage 500 ERP tasks 

• Use the My Tasks pane to customize a task menu structure to fit your daily 
business needs 

• View tasks in the Recently Accessed Tasks pane 

• Access the Help Center (see Help Center on page 137) 

• Access information on the latest Sage 500 ERP enhancements 

• Change the business date or log on with a different user or company 

• Launch system inquiries with Explorer 

• Move and customize toolbars 

• Add and run custom reports (refer to the Installation and System Configuration 
guide). 
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Example 

Following is an example of the Desktop. For an explanation of each component, see 

Components and Navigation on page 37. 
 

Standard 

toolbar 

Main menu 

toolbar 

Company 

Management toolbar 

Web toolbar My Tasks pane 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Tasks 

pane 

Task groups Content page  
Status bar 

Recently 

Accessed 

Tasks pane 
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Components and Navigation 

 
Component functions 

The following table describes the function and navigation of each Desktop 

component. 

 
Component Function Navigation 

Tasks panes Lists the tasks that enable you 
to navigate throughout the 
software and launch tasks. 

Only those tasks for which you 
have access rights are enabled. 
Only users with rights can 
customize the Tasks pane. For 
more information, refer to the 
Installation and System 
Configuration guide. 

 
 
 

 
My Tasks pane This customizable pane enables 

you to add frequently used 
tasks, shortcuts, URLs, task 
groups, and folders for quick 
access. 

• Expand a task group or 
menu to display its 
contents. 

• Based on your computer's 
settings, single-click or 
double-click a task name to 
launch the task. 

• Right-click and select Add to 
My Tasks to add task groups 
or tasks to the My Tasks 
pane. 

• Right-click to add a shortcut 
to the Windows Desktop. 

 
• Right-click and select New 

to add a task, menu, 
shortcut, custom report, or 
URL. The right-click menu is 
also used to copy, delete, 
and rename tasks. 

• Right-click to add a shortcut 
to the Windows Desktop. 

• Customize the order of 
items using drag and drop. 
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Component Function Navigation 

Recently 
Accessed Tasks 
pane 

Provides a list of recently 
accessed tasks. You can drag 
and drop tasks that you have 
access to into the My Tasks 
pane. 

• Right-click to clear the list 
of tasks. 

• Set up the number of tasks 
to display on the Tools 
menu. 

 

Content page Provides a display area for any 
Business Insights task or any 
Web page selected from inside 
the Desktop. 

• Based on your computer's 
settings, single-click or 
double-click a task name to 
launch the task. 

• To open a Web page in a 
new window, press 
SHIFT+Click inside the 
Content page. For more 
information on keyboard 
shortcuts, see System Buttons 
on page 68. 

 

Main menu 
toolbar 

Provides access to functions 
through the following menus: 
File, Edit, View, Tasks, My Tasks, 
Recently Accessed Tasks, Tools, 
Window, and Help. 

• Click a menu to see a list of 
that window's menu 
options. 

• Select the Find option from 
the Edit menu to perform a 
search in the Content page. 

• Dock the Desktop to the top 
of your Windows desktop. 
For more information, see 
Moving and Docking the 
Desktop on page 40. 
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Standard 
toolbar 

 
 
 
 
 
 
 
 
 

 
Company 
Management 
toolbar 

 
Web 
Navigation 
toolbar 

 

Menu 
Maintenance 
toolbar 

 

Task 
Maintenance 
toolbar 

Includes the Dock Desktop, 
Tasks, My Tasks, and Recently 
Accessed Tasks buttons. 

 
 
 
 
 
 
 
 

 
Use the buttons on this toolbar 
to open a company or change 
the currently logged on user. 

 
Provides the standard Internet 
Explorer navigation buttons, 
including Back, Forward, Stop, 
Refresh, and Home. 

 

Use the buttons on this toolbar 
to create, save, and open task 
menus, if you have access rights 
to do so. 

 

Use the buttons on this toolbar 
to add, move, change, and 
delete tasks on a menu, if you 
have access rights to do so. 

• Click the Dock Desktop 
button to hide the full 
Desktop and dock the 
Standard toolbar, My 
Toolbar, and Status bar at 
the top of your Windows 
desktop. 

• Click the Tasks, My Tasks, 
or Recently Accessed Tasks 
buttons to select from a list 
of the available Sage 500 
ERP tasks. 

 
• Click the Open Company or 

Change User button to open 
the logon window. 

 

My toolbar A blank toolbar where you can 
add your own buttons. 
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Status bar Contains information on the 
status of the Desktop, 

including: 

• License type 

• Task menu type 

• Current user and company 

• Business date 

• Right-click the Status bar to 
change the user, company, 
or business date. 

 

Desktop 
toolbar 

Displayed only when the 
Desktop is docked. Includes the 
Standard toolbar and My 
toolbar buttons, Status bar 
information, Exit, and Help 
buttons. 

• Click the Show Full Desktop 
button to return the 
Desktop to its maximized 
state. 

• Click the Help button to 
open the Help Center. 

• See Moving and Docking the 
Desktop on this page. 

 
 

 

Moving and Docking the Desktop 

 
Docking 

When docked, the full Desktop is hidden and the Standard toolbar is docked at the 

top of your monitor, providing more free space on your desktop. In the docked 

mode, you have access to the following: 

• Tasks, My Tasks, and Recently Accessed Tasks menus 

• Options for opening, closing, and selecting companies 

• Logon window for changing users 

• Business date selection window 

• Help Center 

• Buttons on My toolbar 
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To dock the Desktop, click the Dock Desktop button on the Standard toolbar. 

 

 

Example 

The following window shows the Desktop in the docked mode at the top of the 

Windows desktop. 
 

Click the Show Full 

Desktop button to 

undock the 

Desktop. 

Tasks  My Tasks 
 
 

Recently 

Accessed 

Tasks 

Change 

company Change 
user 

Help 

Center 

 
Exit   
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Customizing the Desktop 
 

 
Overview 

You can customize the Desktop in the following ways: 

• Move Explorer bars, including Tasks, My Tasks, and Recently Accessed Tasks. 

• Add and change tasks in a menu. 

• Customize toolbars, including changing their location, showing and hiding 
them, adding or removing buttons, and changing toolbar attributes. 

 

Sage 500 ERP administrators can perform additional customizations. For 

information, refer to the Installation and System Configuration guide. 

 

Locking the Desktop 

 
Description 

Before performing customizations, unlock the Desktop. When you lock the Desktop, 

you cannot perform these customizations. Consider locking the Desktop to prevent 

accidental changes. 
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Procedure 

To lock or unlock the Desktop, from the Tools menu, select Lock Desktop. The icon 

next to the Lock Desktop command indicates the present state of the Desktop and 

what selecting the command will do. 
 

Icon Description 

The Desktop is currently locked. 

Select this command to unlock the 
Desktop. 

The Desktop is currently unlocked. 

Select this command to lock the 
Desktop. 

 

 

Moving Explorer Bars 

 
Moving bars 

When the Desktop is unlocked, drag and drop to move the Explorer bars to another 

part of the Desktop or to your Windows desktop. 

 

Returning bars to docked positions 

Double-click the title bar to return the Explorer bars to the previously docked 

position. 

 

Moving Task panes independently 

Double-click the top of the Tasks, My Tasks, or Recently Accessed Tasks pane to 

move the three Tasks panes independently. 

Tip: When moving the Tasks panes to a position inside the Desktop, place 

the tip of your mouse pointer to the edge of the location in which you want 

to “drop” the Tasks panes. 



Common Navigation Features 

Getting Started 44 

 

 

 

Adding, Changing, and Grouping Tasks 

 
Description 

You can customize the Tasks panes by reorganizing task groups and tasks and by 

adding tasks, custom reports, URLs for Web sites, and documents created with other 

programs, such as Microsoft Excel and Word. 
 

Use My Tasks for adding and arranging the tasks you want to use. The Tasks pane can 

be changed only by users with appropriate access rights. For more information, refer 

to the Installation and System Configuration guide. 

 

Commands for customizing tasks 

Commands for customizing tasks are available by right-clicking the Tasks panes or 

by using the Task Maintenance toolbar. To access the Task Maintenance toolbar, 

select the View menu > Toolbars > Task Maintenance. 

 

Adding tasks 

To add a task 

1 Right-click the Tasks or My Tasks pane where you want to create the task. 

2 From the menu that appears, select Create New Task, then select whether you 

are adding a shortcut (to a file or program), task, custom report, or URL. 

Complete the window that appears by doing the following: 

► For a shortcut to a file or program, type the location of the file you are 

adding or click Browse. Type the name that you want to appear in Tasks or 

My Tasks. 

► For a task, select the module and task. Type the name that you want to 

appear in Tasks or My Tasks. 

► For a custom report, select the module and custom report. Type the name 

that you want to appear in the pane. Type a name and description for the 

report and select if the report is Web enabled. 

► For a URL, type the Web site address and a name that you want to appear 

in the pane. 
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3 Click OK. 

 

Adding from the Tasks pane 

You can also add task groups and tasks from the Tasks pane to the My Tasks pane. 

Do either of the following: 

• Right-click the task group in the pane. From the menu that appears, select Add 
Task Group to My Tasks. 

• Right-click the task in the pane. From the menu that appears, select Add to My 
Tasks. 

• Drag and drop the task from the Tasks pane. To separate the Tasks panes, 
unlock the Desktop and double-click the My Tasks pane. You can then drag the 
My Tasks pane anywhere on the screen. Drag and drop tasks from the Tasks 
pane to where you want them to appear in the My Tasks pane. To dock the My 
Tasks pane again, double-click the My Tasks pane heading. 

 

Adding from the Recently Accessed Tasks pane 

You can add tasks from the Recently Accessed Tasks pane to the Tasks and My Tasks 

panes. Do either of the following: 

• Right-click a task in the pane. From the menu that appears, select Copy and 
paste to the pane. 

• Right-click a task in the pane. From the menu that appears, select Add to My 
Tasks. 

• Drag and drop tasks to the desired pane. 

 

Grouping tasks 

You can add and insert a group of tasks to the Tasks pane. 

1 Right-click a group of tasks. 

2 From the menu that appears, select Add Task Group. 

3 In the Add Task Group window, type the name for the group, the path of the 

content to display, and select the icon to use for the new group. 
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4 Click OK. 

 

Using folders to organize tasks 

You can use folders to organize tasks in the My Tasks pane. To create a folder 

1 Right-click where you want a folder to appear. 

2 From the menu that appears, select Create New Task, then Folder. A folder 

appears in the My Tasks pane ready for you to type in a name. Type the name 

of the folder and press ENTER. 

You can rename a folder by right-clicking it and selecting Rename from the menu 

that appears. 

 

Arranging menu items 

To change the order of menu items and to place items in folders, do either of the 

following: 

• Drag and drop them to the desired location. 

• Use the arrow buttons on the Task Maintenance toolbar to move items up and 
down the list or move them to the left up one level or to the right down one 
level. 

 

Deleting menu items 

To delete a task group or menu item, right-click it, and select Delete Task Group or 

Delete Task from the menu that appears. If a task group or menu item is deleted, you 

will need to re-create it. 

 

Customizing Toolbars 

 
Description 

You can customize toolbars by doing the following: 

• Move toolbars any place on the screen. 
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• Select which toolbars appear. 

• Add or delete your own custom toolbars. 

• Add or remove toolbar buttons. 

• Set toolbar options. 

 

Moving toolbars 

When the Desktop is unlocked, a bar appears on the left side of each toolbar. 
 

Bar for moving toolbar 

 
 
 

Toolbar Options button 

 

To move a toolbar, click the bar and drag the toolbar to the desired location, 

including outside of the Desktop window. To dock a toolbar, drag it to the desired 

location near an inside edge of the Desktop window. 

 

Opening the Customize Toolbar window 

Use the Customize window to select toolbars to appear, add and delete custom 

toolbars, change toolbar buttons, and set toolbar options. 

Open the Customize window for toolbars by doing either of the following: 

• Select Tools menu > Customize Toolbars. 

• Click the Toolbar Options button. From the menu that appears, select Add or 

Remove Buttons and then Customize Toolbars. 
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The Customize window appears: 

 

 

Creating a new toolbar 

To create a new toolbar 

1 In the Customize window, click New. 

2 In the New Toolbar window that appears, type a name for the toolbar and its 

initial location. 

3 Click OK. An empty toolbar appears in the Desktop window. 

4 In the Customize window, click the Commands tab. This tab lists the available 

commands for Desktop toolbars including all tasks. 

5 Drag the button from the Commands tab to the desired location on the 

toolbar. 

6 Click Close. 

 

Changing custom toolbars 

You can rename or delete toolbars you have created. On the Toolbars tab in the 

Customize window, select the custom toolbar. Click Rename or Delete. 

Note: You cannot rename or delete a toolbar provided with Sage 500 ERP. 
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Changing buttons on toolbars 

You can add or remove buttons on custom toolbars and those provided with Sage 

500 ERP. 

Adding buttons 

To add buttons to a toolbar 

1 Open the Customize window. 

2 In the Customize window, click the Commands tab. This tab lists the available 

commands for Desktop toolbars, including all tasks. 

3 Drag the button from the Commands tab to the desired location on the 

toolbar. 

4 When you are finished, click Close. 

Removing buttons 

To remove buttons from a toolbar 

1 Open the Customize window. 

2 Drag the button off the toolbar. The Customize window can be open to any 

tab. 

3 When you are finished, click Close. 

Hiding buttons 
 

To temporarily remove buttons from a toolbar, you can hide them. You can show the 

buttons again if you want to use them later. 

Follow these steps: 

1 Click the Toolbar Options button. From the menu that appears, select Add or 

Remove Buttons and then the name of the toolbar. A menu appears with the 

buttons on the toolbar. A check appears next to the buttons that are showing. 

2 Select the button to hide. It is hidden from the toolbar and the check is 

removed. 

3 To show the button again, select it again. 
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Resetting toolbar customization 

To return a toolbar to its default settings, click the Toolbar Options button. From the 

menu that appears, select Add or Remove Buttons and then the name of the toolbar. 

A menu appears with the buttons on the toolbar. Select Reset Toolbar. 

 

Setting toolbar options 

The Options tab on the Customize window enables you to set options for toolbars 

and menus, including the size of icons and appearance of menus. 

 

Setting Keyboard Shortcuts 

 
Description 

The Customize window also allows you to assign keyboard shortcuts for commands 

and tasks. Perform the following: 

1 Click the Keyboard button on any of the Customize window tabs. 

2 In the Categories and Command boxes, select the command or task to which 

you are assigning a shortcut. 

3 Select the key combination in the Specify a Shortcut field. If it is already 

assigned to a shortcut, it is indicated below the field. 

Note: If you need to return keyboard shortcuts to the defaults, click Reset 

All. 
 

For more information about keyboard shortcuts, see System Buttons on page 68 and 

Using Keyboard Shortcuts in a Line Entry Grid on page 88. 
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Common Menus 
 

 
Introduction 

This section provides an overview of common menus and their respective tasks. 

Setup tasks are also included on the Maintenance menu. 

 

Detail information 

Detailed information on tasks is provided in the Help system. 

 

Menu functions 

The following table describes the function of each common menu. 

 
Menu Function 

Maintenance • Establish settings and define 
information about your companies, 
users, and security groups. 

• Revise or update information. For 
example, in the System Manager 
module, use Maintain Companies to add 
a new company. 

• Use Set Up Options to perform various 
functions automatically. These settings 
are system wide and affect all users. For 
example, you can print user IDs on 
reports, require users to enter passwords, 
and retry failed data updates to the 
server at specified intervals. 
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Menu Function 

Activities Perform common tasks. For example, 
register new modules, purge activity logs for 
any module, enter/process transactions, 
perform period-end processing, or print 
forms. 

 

Reports Print reports that show what activities have 
taken place in your system or in your 
companies. 

 

Insights • View activity/history in your system or 
in your companies. 

• Retrieve related data. 

• View details of data you currently have 
in a summary field. 

Tools • Available only in the System Manager 
module. 

• Primarily used by the system 
administrator or person responsible for 
the setup and configuration of the 
system. 

• Settings generally affect all users on the 
system; however, the User Preferences 
menu options affect only the user that is 
currently logged on. For more 
information, see Setting User Preferences 
on page 53. 

For more information on using the Tools 
menu, refer to the Installation and System 
Configuration guide. 
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Setting User Preferences 

 
System Manager settings 

In System Manager, the User Preferences task on the Tools menu allows you to select 

settings that affect only the user that is currently logged on. The preferences you can 

set include the following: 

• Enable the ENTER key to function like the TAB key during data entry. 

• Use flat toolbar buttons in all windows. 

• Maximize report windows. 

• Show the Customizer, DataPorter, and Sage 500 ERP Office buttons on task 
window toolbars. 

► The Customizer button launches the Customization window, which allows 

you to customize task windows. 

► The DataPorter button launches an Excel window with a DataPorter 

toolbar, which allows you to import data to and export data from Excel. 

► The Sage 500 ERP Office button launches the Sage 500 ERP Office window, 

which allows you to generate merged documents in Word and Excel. 

• Use the same business date for all modules. 

• Use the system date for the business date. 

• Use the transaction date for the post date for batchless transactions. 

• Use the system date as the default business date. 

• Define or change passwords. 

• Select a default printer for picking and invoices. 

• Select a default sales order entry warehouse, salesperson, and delivery method. 
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Search Features 
 

 
Overview 

Search features help you locate the information you need, without the need to scan 

long lists of information. 

 

Search types 

The software employs several search features, which are discussed in the following 

sections: 

• Lookup and Navigator 

• GL Account 

• Business Insights 

 
 

Lookup and Navigator 

 
Purpose 

The Lookup (the magnifying glass) and Navigator (the flashlight) buttons are query 

tools that allow you to access a database table or view information linked to the 

current field of your open window. 
 

For information about administering the customization of Lookups, refer to your 

Installation and System Configuration guide. 
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Example 

The following window displays the Lookup and Navigator buttons. 
 
 
 

 
Navigator button 

 

Lookup button 

 

Functions 

The following table describes the functions of the Lookup and Navigator search 

tools. 
 

Search 

tool 

Keyboard 

shortcut Function 
 

 

Lookup F5 • Field search 

• Retrieves data only for the field 
next to the Lookup button 

• Each Sage 500 ERP task window 
can have several fields with 
Lookup buttons 

 

Navigator F4 • Record search 

• Retrieves the complete record 
for the selected item 

• Only one Navigator button is 
available on any task window 

• After you select an item, the 
selected data is inserted into all 
fields referenced in the record 
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Search engine capabilities 

By clicking the Lookup or Navigator button, you open a database search engine that 

allows you to: 

• Conduct broad or narrow searches per the conditions you define. 

• Drag and drop to change the row and column order. 

• Specify filter criteria to display only the data you have selected. 

• Perform a quick search of data on a single field. 

• Easily locate a general ledger account. 

• Customize the appearance of Lookup windows, including the columns that 
appear. 

• Copy the grid data to other programs such as Microsoft Word or Excel using 
the Copy button in Lookup windows. 

• Reset the filtered criteria to view all the data in the grid. 

• View detailed information for the Lookup and Navigator controls in the Help 
system. 

 

Searching for data 

Click the Lookup or the Navigator button at a data entry field to start a search. For 

more information, see Search in the Help system. 
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The Lookup window displays the options for the field that you have defined in your 

system. Double-click a row to select an option. The Lookup window closes and the 

field is populated automatically with your selection. 

 

 

Use the Filter tab 

to search for items 

by several fields. 

See Filtering your 

search on page 58. 

Click to open or close the Filter tab. 
 
 

Drag the border 

between the Filter 

tab and grid to 

change the size. 
 

Up/down arrows 

identify ascending   

or descending sort 

order. 

 
Double-click a row 

to select it. 

 
 
 

Click a column 

header to sort the 

grid by this 

column. 

 

Use the Quick 

Search fields to 

search by a single 

field. See Using 

Quick Search on 

page 58. 
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Using Quick Search 

Quick Search enables you to search for data by a single field. Select the field and 

search criteria in the Quick Search fields and click Search. The results appear in the 

grid. 
 

Select the field 

for the search. 

 

Select the search 

condition (such 

 

Type the text to search for. (If you 

select Is Between or Is Not 

 
Click to begin the search. 

 

Filtering your search 

To search by more than one field, use the Filter tab. If the Filter tab does not appear, 

click the Filter On/Off button. 
 

In the Filter tab, select the search condition and text for each field. If you select Is 

Between or Is Not Between, two fields open to the right of the condition so that you 

can set the start and end of the range. When you have selected the search criteria, 

click the Refresh button. 
 

The results appear in the grid. 

as Begins with). Between, both fields are 

enabled.) 
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Searching for account numbers 

Click the Lookup button next to a general ledger account field to locate an account 

number using the Advanced tab. 

 
 
 

 

You can enter a 

natural account, 

a shortcut ID, 

and segment 

criteria to filter 

the account 

numbers. 

 
 
 
 
 

 

Using the Record Filter 

After you have closed the Lookup window, you can still use the selection criteria you 

made to browse through records in the form. 
 

Use the Record Filter button on a form to retain the most recently defined search 

criteria you selected in a Navigator Lookup window. 
 

 
When the Record Filter button is selected, only the records that meet the conditions 

last defined in the Navigator Lookup window will display. The filter allows you to 

toggle on and off the most recently defined search conditions. If you turn the filter 

off, any data that you access is selected from the entire database. 
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Search shortcut 

Quickly perform a search based on text you enter in a field with an associated 

Navigator or Lookup button. When you enter text in the field and then select the 

Navigator or Lookup button, the search criteria on the Lookup window's Filter tab 

automatically populates with your entry, and all related records appear in the grid. 

Example 

In Accounts Payable Maintain Vendors, select only those vendors beginning with 

the letter "A" by typing "A" at the vendor field before clicking the Navigator button. 
 

 

Saving filter settings 

To save filter settings, select the Save Filter check box. The settings appear the next 

time you use the window. 
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Changing the Lookup Window 

 
Description 

You can customize the appearance of Lookup windows by selecting the columns that 

appear, their order, and column widths. When you have made the changes, save 

them so they are used each time you open the Lookup window. 

 

Changing columns 

To change the columns that appear in the grids for the Filter tab and search results, 

click the View Columns button in the Lookup window toolbar. 
 

The Lookup View Columns window appears. 
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Use the window as follows: 

• To select which columns appear in the grid, select the check box to the left of 
the column name. Selected columns appear in the grid and cleared columns do 
not. 

You can also click the Show/Hide button to select or clear columns. If you select a 

cleared column, the button changes to Show so that you can click to select it. If 

you select a selected column, the button changes to Hide so that you can remove 

it from the grid. 

• To change the order the columns appear, use the Move Up or Move Down 
buttons to move the selected columns. To help you set the column order, select 
the Display only selected columns check box to show only the columns you 
have selected for the grid. 

• To change the default column width, use the Column Width field. Set the 
number of characters in the column. 

• To change the title for the column as it appears in the grid, type the new name 
in the Column Caption field. The original column name appears in the 
Original Caption field for reference. If you have administrator rights, you can 
change the original caption. 

 

When you have finished making your changes, click OK. The grid changes according 

to the settings you made. 

 

Changing columns in the grid 

In the Lookup window, you can change the appearance of the columns in the 

following ways: 

• To change the position of any data column, click the column heading to 
highlight it and drag it to another position. 

• To resize columns, click and drag the column borders within the heading to 
adjust the column width. 

 

Saving views 

When you close a Lookup window, the column changes you make are retained and 

appear the next time you open the Lookup window. 
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If you plan to use the column format changes frequently, save them as a view. Views 

can include filter settings. When you open the Lookup window, you can select a 

view, and it applies the grid layout and filter settings you saved. You can save 

multiple views for a Lookup window. One of the views must be set as the default. 
 

To save a view, click the Save As button. 
 

The Save Lookup View As window appears. 
 

 
Type a name for the view and select whether it is the default view for the Lookup 

window, and whether to save filter settings with the view. Click OK. 

Note: To change an existing view, type the view name at the Lookup View 

field. You are prompted to overwrite the view. 

 

Resetting views 

To restore a view to the settings defined by the administrator, click the Reset button. 

 

Deleting views 

To delete a view, click the Delete button. This button is disabled for views created by 

the administrator. 
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GL Account Structured Search 

 
Purpose 

The GL Account Structured Search provides an additional method for locating 

general ledger account numbers. Unlike the Navigator or Lookup search, which 

organizes general ledger accounts by number, the structured Search window uses a 

hierarchical tree view that organizes the accounts by account category and account 

group. This type of search is useful in finding a particular account number when you 

know the account function or type. 

 

Example 

Click the Structured Search button to open the GL Account Structured Search 

window. 

 

 

 

More information 

For more information, see the Help system. 
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Business Insights 

 
Purpose 

Use Business Insights features to view and edit stored information as you work. For 

example, you might want to view a customer's account aging and their latest 

payment information. You can access this type of information by right-clicking the 

selected fields for which details are available or by selecting a task from the Business 

Insights menu. 

 

Business Insights Options 

There are five ways to view or edit related information while you are processing a 

transaction: 

• Explore 

• Previews 

• Drill Into 

• Analyze 

• Manage 
 

To edit or view historical information, right-click a primary field and select the 

appropriate option. 
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Right-click a field 

to display a menu 

that lists Business 

Insights options. 

 
 
 
 
 
 
 
 
 
 

Explore 

Explore options allow you to view data in the context of a selected field. For 

example, if a general ledger account field is selected, you can view data for the 

selected general ledger account. 

 

Previews 

Previews options allow you to quickly view grids of related data. 
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Drill Into 

Drill Into options allow you to view related data, such as general ledger transactions. 
 

 
Analyze 

Analyze options allow you to view pivot tables and charts for related data. 

 

Manage 

Manage options allow you to perform tasks related to selected data. 

 

More Information 

For more information, see the Help system. 
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System Buttons 
 

 
Button functions 

The following tables define the system buttons used throughout the software. Use 

keyboard shortcuts to initiate many of the same functions provided by these 

buttons. 
 

Toolbar buttons 

 

Button 
Name

 
[keyboard shortcut] Function 

Sage 500 ERP Office 
[CTRL+SHIFT+E] 

Opens Sage 500 ERP 
Office. 

 

 

Cancel 
[CTRL+L] 

 
 

Cancel and Exit 
[CTRL+SHIFT+L] 

Clears the currently 
entered, unsaved data 
and keeps the task 
window open. 

 

Clears the current 
window and returns you 
to the Desktop or to the 
main window of the 
current task. 

 

Cancel Process Cancels the current 
Business Insights process. 

 

 

Change Business 
Date 

Changes the system 
business date. 
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Button 
Name

 
[keyboard shortcut] Function 

Change User Click to change the 
currently logged on user. 

 
 

 
Close 
[CTRL+Q] 

 
Closes the window. 

 
 
 

Commit 
[CTRL+T] 

 
Commits a shipment or 
customer return. 

 

 

Copy 
[CTRL+C] 

Copies the selected 
information or graphic to 
the clipboard. 

 
Customizer 

[ALT+F3] 

 
 

DataPorter 

[ALT+F7] 

 
 
 
 

DataPorter Metadata 

[ALT+F8] 

Opens the Customization 
window, which allows 
you to modify the 
window. 

 
Opens Microsoft Excel 
with the DataPorter 
toolbar, which allows you 
to import data from and 
export data to Microsoft 
Excel. 

 

Opens the DataPorter 
Metadata window, which 
allows you to create the 
infrastructure DataPorter 
requires to create the 
spreadsheet, and import 
or export data. 
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Button 
Name

 
[keyboard shortcut] Function 

Defer 
[CTRL+F] 

 
 
 
 

 
Delete 
[CTRL+D] 

Delays printing of the 
current report/list, saves 
it, and places it in the 
repdata folder in System 
Manager. For more 
information, see Deferred 
Printing on page 126. 

 

Deletes the selected 
record. 

 
 
 

Dock Desktop Hides the full Desktop 
and docks the Desktop 
toolbar at the top of your 
Windows desktop. 

 

Export Report 
[CTRL+SHIFT+X] 

 
 
 

Finish 
[CTRL+F] 

 
 

Finish and Exit 
[CTRL+SHIFT+F] 

Exports the report to a 
third-party package, file, 
HTML, or e-mail, such as 
Excel, Word, Exchange, 
or Outlook. 

 

Saves the current entry 
and clears all data from 
the window; the window 
remains open. 

 

Saves the current entry 
and closes the current 
task window. 

 
Help 
[CTRL+H] 

Opens Form-level 
(overview) Help. See 
Using the Help System on 
page 132. 
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Button 
Name

 
[keyboard shortcut] Function 

Help Center Opens the Help Center. 
See Help Center on 
page 137. 

 
Memo 
[CTRL+M] 

 
 
 
 

 
Memo 
[CTRL+M] 

 
 
 

 
Memo 
[CTRL+M] 

 
 
 
 

 
My Tasks 
[ALT+M] 

Allows you to enter a 
memo for the current 
record. After the memo is 
saved, the Memo icon 
changes to indicate a 
memo exists for the 
record. 

 

Allows you to enter a 
memo for the current 
record or change an 
existing memo. Indicates 
a memo already exists for 
the selected record. 

 

Allows you to enter a 
memo for the current 
record or change an 
existing memo. Indicates 
a priority memo already 
exists for the selected 
record. 

 

Displays the My Tasks 
pane. 

 
 
 

Next Number 
[CTRL+N] 

 
Assigns the next available 
number in an 
automatically numbered 
field. 
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Button 
Name

 
[keyboard shortcut] Function 

Open Company Click to change the 
current company. 

 

 

Preview 
[CTRL+W] 

 
 
 

 
Print 
[CTRL+P] 

Displays the current 
report or list 
on the screen. For more 
information, see 
Previewing Reports on 
page 124. 

 

Prints the current report 
or list. 

 

 

Proceed 
[CTRL+O] 

Begins processing. 

 

 

Refresh 
[CTRL+SHIFT+R] 

Refreshes data in the 
current window. 

 

 
Rename ID 
[CTRL+R] 

 
 

 
Recently Accessed 
Tasks 

Assigns a new ID to the 
current record. All 
historical information is 
tracked under the new 
ID. 

 

Displays the Recently 
Accessed Tasks pane. 
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Button 
Name

 
[keyboard shortcut] Function 

Reset 
[CTRL+SHIFT+R] 

Resets the entry and all 
data displayed in the 
window. 

 

Save 
[CTRL+S] 

Saves the current entry, 
and all data remains 
displayed in the window. 

 
Search Text Searches for specific 

information on a report 
or list. Used in 
conjunction with the 
adjacent text entry field. 

 

Stop Halts printing of a 
multiple page report. This 
button is enabled only 
when printing a multiple 
page report. 

 

Tasks 
[ALT+T] 

 

Displays the Tasks pane. 

 

 

Tree View Toggles the tree view to 
the left of the report 
preview window on or 
off. 

 

Zoom Resizes the page in the 
display window. Use the 
down arrow to select Page 
Width, Whole Page, or a 
percentage. 
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To view buttons that can be added to toolbars, use the Customize Toolbar command 

in the Tools menu when the Desktop is unlocked. For more information, see 

Customizing Toolbars on page 46. 

Additional buttons 

 

Button 
Name

 
[keyboard shortcut] Function 

Export to Excel 
[CTRL+SHIFT+E] 

Export data to Microsoft 
Excel. 

 

 

Filter (On) 
[CTRL+B] 

 
 
 
 
 
 
 
 
 

 
Filter (Off) 
[CTRL+SHIFT+C] 

Toggles the display of the 
filter criteria in a Lookup 
window. 

When selected in a 
Lookup window, displays 
the Filter tab to limit the 
information that appears. 
If filtering on a general 
ledger account field, 
displays the Advanced 
tab to further limit the 
information. 

 

Cancels the filter criteria 
in a Lookup window. 

 

 
Go to First Record 
[CTRL+SHIFT+U] 

Opens the first record in 
the database or 
Navigator, depending on 
the Record Filter mode. 
For more information, see 
Using the Record Filter on 
page 59. 
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Button 
Name

 
[keyboard shortcut] Function 

Go to Last Record 
[CTRL+SHIFT+O] 

 
 

Go to Next Record 
[CTRL+SHIFT+P] 

 
 
 
 

 
Go to Previous 
Record 
[CTRL+SHIFT+I] 

 
 
 

 
Map 
[ALT+Q] 

Opens the last record in 
the database or 
Navigator, depending on 
the Record Filter mode. 

 

Opens the record 
following the current 
record loaded in the 
window in the database 
or Navigator, depending 
on the Record Filter 
mode. 

 

Opens the record 
preceding the current 
record loaded in the 
window in the database 
or Navigator, depending 
on the Record Filter 
mode. 

 

Displays a map for the 
address displayed in the 
window. 

 
 

More Opens a window where 
you can enter additional 
information. 
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Button 
Name

 
[keyboard shortcut] Function 

Record Filter On/Off 
[CTRL+T] 

 
 
 
 
 

 
Structured Search 
[SHIFT+F5 when 
next to a Lookup, 
SHIFT+F4 when next 
to a Navigator, or 
CTRL+SHIFT+T 

when it appears by 
itself] 

When used in 
conjunction with the 
Navigator, limits the 
search information 
available for display. For 
more information, see 
Using the Record Filter on 
page 59. 

 

Enables you to select an 
item from a heirarchical 
list, such as general ledger 
accounts and payments 
and inventory items. 

 
 



Common Navigation Features 

Getting Started 77 

 

 

 

Function Keys 
 

 
Definitions 

Use your keyboard function keys to perform the following actions: 
 

Key Function 

F1 Displays help for the current field while in a task. 
You can also right-click > What’s This? in the 
current field of each task. 

 

F3 Updates (or refreshes) the field with data added 
since opening the window. 

F4 Opens the Navigator search window to retrieve 
data for all related fields in the current window. 

 

F5 Opens the Lookup search window to retrieve data 
for the current field. 

 

F12 If account shortcuts have been defined in General 
Ledger Maintain Account Shortcuts, use the F12 
key when in the Accounts field to enable the 
shortcut, which automatically enters the full 
general ledger account number. For more 
information, see the Help system. 

 

ALT+F3  Opens the Customization window for the current 
Sage 500 ERP window. For more information, see 
the Help system. 

ALT+F4 Closes the current Sage 500 ERP task window. 

ALT+F7  Opens DataPorter. For more information, see the 

Help system. 
 

 

You can define additional keyboard shortcuts. For information, see Setting Keyboard 

Shortcuts on page 50. 
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Grids 
 

 
Populating a Grid 

 
Entering data 

To populate the grid, enter data in the required fields above the grid. In the 

following example, you must enter data in the Company and Group fields. Press 

ENTER or click OK to transfer the data to the grid. 
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Editing Text in a Grid 

 
Options for editing 

Depending on the type of grid you are working with, there are two ways to edit text 

in a grid: 

• Click the grid line to select it. This causes the fields above the grid to populate 
with information. You can then change the data in these fields and click OK to 
update the data in the grid. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select a row in the grid 

to display the 

information in the fields 

directly above the grid. 
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• Select the grid line and make the changes to enabled fields inside the grid. 

 

 
 

Customizing Columns in a Grid 

 
Ways to customize 

Columns in a grid can be customized in the following ways: 

• Click and drag the edge of the column heading in some grids to resize the 
column width. 

• Sort the order of column lines in some grids by clicking the column heading. 

• Click the column heading and drag the column to another location. 

Note: When you resize columns in a grid, the new sizes are not saved when 

you close the window. 
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Up or down arrows in   

the column heading 

identify an ascending 

or descending sort 

order. 

 

 
Resize the width of 

each column in the 

grid by dragging the 

edge of the column 

to the right or left. 

 
 
 
 
 
 
 
 
 
 

Selecting a Row in a Grid 

 
Ways to select 

Rows in a grid can be selected in two ways: 

• Select each row by clicking the row numbers that appear at the left of the grid. 

• Select a range of rows by clicking a row number, and then clicking another row 
number while holding down the SHIFT key. 
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Working with Lines in a Grid 

 
Line options 

When you click a line in a grid and then right-click, a menu appears that allows you 

to: 

• Add a line. 

• Delete a line. 

• Select Business Insights tasks. 

 

Export and print options 

Some grids also allow you to right-click to: 

• Export the data in a grid to an Excel (.xls) file format. 

• Export the grid data to a template (for more information, see Exporting Grid Data to 
a Template on page 84). 

• Print the data in the grid to the default Windows printer. 
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Moving lines 

In some grids you can move a line by clicking the row number and dragging the row 

to the desired location. 
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Exporting Grid Data to a Template 

 
Overview 

The Export to Template feature enables you to export data from a grid to an existing 

Excel file. This file may contain preformatted views of the exported data, such as 

pivot tables and graphs. It is assumed you have some familiarity with Microsoft 

Excel. 
 

The Export to Template option appears on right-click menus associated with grids. 

At least one template must be associated to the form for this option to be enabled. To 

associate an Excel template to a form, see Template association on page 86. 

 

Template selection 

When you select Export to Template: 

• An Excel export template is selected. 

• If no template is selected, a new Excel workbook is created. 

• Contents of the grid are exported to the selected Excel template. 

• The Excel workbook created using the template is displayed. 
 

If there is only a single template associated with the form, then it is used, providing 

it exists. If more then one template is associated with the form, you select a template 

or browse to a template from the Export Template Selection window. 

 

Creating an Excel template 

Each Excel template created to use the Excel Export to Template feature must be 

formatted to use the latest exported data. To create a new template: 

1 Select the task for which you want to create a template. The window must 

contain a grid. 

2 In the task window, select the desired options to populate the grid with data. 

3 Right-click the grid and select Export. This option creates an Excel spreadsheet 

that contains the raw grid data. 
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4 Rename Sheet 1 to Source. This worksheet will be refreshed each time you 

export to this template. 

5 From the Excel Insert menu, select Name and then Define. 
 

6 Notice the named range called SourceInfo that includes all columns and rows. 

The named range is updated each time the template is used to reflect the 

correct number of columns and rows. Any references made to the source 

worksheet from other worksheets should reference this named range. This 

ensures that when the template is opened and the worksheets are refreshed, it 

will reference all rows and columns generated in the source worksheet. (Excel 

does not recognize when new rows are added to a worksheet that may affect a 

named range.) 

7 Create additional worksheets that reference the source worksheet. Include 

pivot tables and graphs, as desired. 

8 Save the template to an Excel file. Use the naming convention defined in 

Template association on this page. Additionally, you can save multiple templates 

per task. In this scenario, use a name that reflects the given task and add it to 

the template list file, as defined in Adding a template to the template list file on this 

page. 
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Template association 

Each form can have multiple Excel export templates associated with it. These 

templates are located in the GridTemplates folder under the client installation 

folder. A template can be associated to a form in two ways: 

• The template is located in the GridTemplates folder, and the filename and 
form caption are the same. 

• The template is associated to the form by an entry in the TemplateList.xls file. 

 

Adding a template to the template list file 

The template list file TemplateList.xls can be used to associate one or more Excel 

templates to a specific form. When using the Template List file to publish templates 

for a given form, the actual template can reside in any folder; however, the 

TemplateList.xls file must be located in the GridTemplates folder. 

If you do not have a folder called GridTemplates in your client folder (default - 

C:\Program Files\Sage Software\Sage MAS 500 Client), you must create this folder, 

as well as an Excel file named TemplateList.xls (located under the GridTemplates 

folder) to proceed. 

Example Template List spreadsheet 
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Guidelines 

Use the following guidelines to add a template to the TemplateList.xls file: 

• The template must contain a single worksheet; the worksheet name is not 
significant. 

• The worksheet must contain three columns, in this order: 

► Form name (not case sensitive). 

► Excel export template file name. May contain path information. If no path 

information is included, the default path to the GridTemplates folder is 

prefixed to the file name. 

► Template description. This description appears in the Export Template 

Selection window. 

• The columns must have a header row. The first non-blank row is considered 
the header. The text on the header row is insignificant. 

 

Using Grids to Select Report Criteria 

 
Purpose 

Report grids allow you to define and sort multiple selection criteria for each report. 

 

Sort grid 

The items in the Sort grid determine the order in which items are sorted on the 

report, if subtotals are used, and whether to insert page breaks after selected fields. 

Fields on which you can sort depend on the type of report you are printing. 

 

Example 

The Print System Activity Log includes sort options for the event date and event 

time. 
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Sort grid 

 
 
 
 

Select grid 

 
 
 
 
 
 

Select grid 

The items in the Select grid determine which records appear on the report, based on 

the criteria you enter. For example, you can right-click an item in the Field column, 

which enables you to select a range of values for your report. And indicates required 

inclusion; Or indicates optional use of the specified value. 

 

Using Keyboard Shortcuts in a Line Entry Grid 

 
Shortcut definitions 

Keyboard shortcuts are described in the following table. 

 
Keyboard shortcut   Function 

ALT+HOME Moves the cursor to the first field 
above the grid 

 
ALT+END  Returns the cursor to the row 

previously highlighted in the grid 
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Keyboard shortcut Function 

SHIFT+END Displays the far right column cell in 
the grid 

 
SHIFT+HOME Displays the far left column cell in 

the grid 
 

HOME  Displays and highlights the first line 
or first column cell in the grid 

 

END Displays and highlights the last line 
or last column cell in the grid 

 

Up or Down arrow Moves the cursor from row to row 
 

CTRL+Up or Down 
arrow 

CTRL+Up or Down 

arrow 

Repositions a highlighted row to a 
new position in the grid 

Drags the current grid line entry up 

or down one line 

ESC  Cancels the current entry and moves 
the cursor from a data entry field to 
the grid below 

 

ENTER Moves the cursor from a highlighted 
grid line up to a data entry field for 
editing 

PAGE UP Moves the cursor to the first line 

PAGE DOWN Moves the cursor to the last line 

CTRL+G Displays the Goto Line window, 

which allows you to position the 
cursor at a line number in the grid 
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Using a Mouse to Edit Data in a Grid 

 
Options 

To use your mouse to modify or edit data in a grid, you can: 

• Right-click the grid to display a menu that allows you to add, delete, insert, or 
go to any row. 

• Click and hold (drag and drop) a row or column heading on the grid to move it 
to a new position in the grid (if the grid supports reordering). 
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Dates 
 

 
Definitions 

There are several different types of dates used by the software, which are described in 

the following table. 

 
Date type Description 

Business date • The default transaction and posting 
date. 

• Each module can have its own 
business date. 

• Defined in System Manager. 
 

Transaction date • The date of the actual transaction. 

• Used to age invoices and vouchers. 
 

Posting date • The date the transaction was 
posted. 

• Some reports include information 
based on this date (for example, 
Trial Balance). 

 

Run date • The current system date. 

• Appears on reports. 

• Does not affect postings. 
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Viewing and 
Analyzing Data 
This chapter provides information and procedures for using the 

Business Insights Analyzer, Business Insights Explorer, and 

Business Insights Dashboard. 

In this chapter 

Using the Business Insights Analyzer ...................................................... 93 

Using the Business Insights Explorer ....................................................... 100 

Using the Business Insights Dashboard ................................................ 103 

5 
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Using the Business Insights Analyzer 
 

 
Purpose 

Business Insights Analyzer allows you to identify, analyze, display, and report 

different types of data, such as projects, sales activities, or general ledger activity. 

Use the Business Insights Analyzer to perform the following functions: 

• Display the data set in a Data View grid, pivot table, or chart. 

Note: If you have the supported version of Microsoft® Office installed on 

your PC, the pivot table and chart are used interactively. For information 

on supported versions, refer to the Sage 500 ERP Compatibility and Resource 

Guide. 
 

• Refine data sets using filter tools. 

• Add columns or remove columns that do not apply to the data search. 

• Group or subtotal data. 

• Print the Data View grid and chart information directly. 

• Port the data to the Crystal Report Wizard. 

• Export the data to Microsoft® Excel®, Microsoft® Word®, PDF, or the eXtensible 
Markup Language (XML). 

• Save multiple settings for each Analyzer task. 

 

Accessing the Business Insights Analyzer 

There are several ways to access Business Insights Analyzer, depending on your 

workflow needs. You can access Business Insights Analyzer directly from a window in 

the software or from the Tasks pane located on the Desktop. You can also access the 

Analyzer from a Business Insights Explorer task. 
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To access Business Insights Analyzer from the software: 

1 In any window in the software, right-click the field that has the Business 

Insights Analyzer feature available. 

2 On the right-click menu, select Analyzer, select the task, and then select the 

filter setting name. 

Note: If no customized filter settings have been saved, Standard is the only 

filter that displays. 

3 The Business Insights Analyzer window appears with the data for the selected 

task and filter in view. 

To access Business Insights Analyzer from the Desktop: 

1 In the Desktop, on the Tasks pane, click the Business Insights task group. 

2 Expand the Analyze folder. 

3 Double-click an Analyzer task. The Business Insights Analyzer window appears 

with the data for the selected task and filter in view. 

To access the Analyzer from a Business Insights Explorer task: 

1 In the Business Insights Explorer window, select the Analyze menu or the 

Analyze group in the Explorer bar. 

2 Expand the folder for the data that you want to view. 

3 Select the type of setting to use. Standard is the default setting unless you 

create a new setting and designate it as the default. 

4 The Business Insights Analyzer window appears with the data for the selected 

task and filter in view. 
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Using the Business Insights Analyzer Toolbar 

 
Example 

The illustration below provides more information about the features available on the 

Business Insights Analyzer toolbar. 

 
 

 
Use the buttons on the Analyzer 

toolbar to modify settings and filters, 

and select options for the Data View 

grid, pivot table, and chart. 

 
Use the Filter pane to “fine 

tune” the data set for the 

Analyzer task for improved 

analysis and performance. 

 

 
Use the Setting drop-down 

list to select a saved 

setting or the Standard 

setting for the Analyzer 

task. You can save 

multiple settings for each 

Analyzer task. 

 
 
 

More information 

For more information, see the Help system. 

 
 

Viewing Data in the Business Insights Analyzer 

 
Overview 

After entering a filter and clicking the Refresh button, the resulting data set initially 

displays in the Data View grid for the Analyzer task. 
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Example 

You can view data in a Data View grid, pivot table, or chart by clicking the tabs 

located in the lower-left corner of the Business Insights Analyzer. 

 

 

More information 

For more information, see the Help system. 

 
 

Creating Filters 

 
Procedure 

Use the following steps to enter one or more filters that can be applied to any 

column in the data set. 
 

1 On the Analyzer toolbar, click the Show Filter button. The Filter pane appears. 

2 At the Column field, select a column to apply the filter to. The Column field 

lists every column included in the SQL view. The column selected does not 

have to be one of the columns displayed on the Data View tab. 

3 At the Operator field, select the operator to use to compare the data in the 

column to the value entered at the Value field. For operators that require an 

upper and lower value, a second value can be entered. 

Note: You can also create Boolean searches by selecting And or Or at the 

And/Or field to join multiple filters. 
 

4 At the Value field, enter a value to search on. 

5 Click the Refresh button on the Analyzer toolbar to display the filtered data set 

in the data view, pivot table, or chart. 

Note: You can clear a filter by clicking the Clear Filter button. This removes 

any filters entered regardless if they are either saved or unsaved. 
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More information 

For more information, see the Help system. 

 
 

Using the Data View Grid 

 
Overview 

Use the Data View tab in Business Insights Analyzer to view the current data set for 

an Analyzer task in a grid format. The data view grid allows for grouping and 

summarization of any column by sum, average, count, minimum, or maximum. 

Rows of data can be selected and copied to the Windows Clipboard. 

 

Example 

The following illustration shows the data view grid for the Sales History Analyzer 

task. 
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Creating a Pivot Table 

 
Overview 

Use the Pivot Table tab in Business Insights Analyzer to create a pivot table based on 
the data set for an Analyzer task. This tab contains the Pivot Table control from the 

Microsoft® Office Web® component, providing you with ways to dynamically 
display and organize data from a field list, display filtered data from the data set, 

customize summary and report total options, and export the data to Microsoft® 

Excel®. Click the Field List button to select and drag fields from the PivotTable Field 
List dialog box to columns within the pivot table. 

Note: If Use Pivot Table as Chart Data Source is selected from the Business 

Insights Analyzer Tools menu > Options Menu, data displays based on 

changes to the chart. Likewise, changes made to the chart affect the pivot 

table (such as changes to data and axes). 

 

Example 

The following illustration shows the pivot table view of the Sales History Analyzer 

task. 
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More information 

For more information, see the Help system. 

 
 

Creating a Chart 

 
Overview 

Use the Chart tab in Business Insights Analyzer to create a chart based on the data set 

for an Analyzer task. This tab contains a chart control from the Microsoft® Office 

Web® component, providing you with ways to view and organize data from a field 

list, display filtered data from the data set, and customize the format of the chart. 

Note: If Use Pivot Table as Chart Data Source is selected from the Business 

Insights Analyzer Tools menu > Options Menu, data displays based on 

changes to the pivot table. Likewise, changes made to the pivot table affect 

the chart (such as measures and dimensions). 

 

Example 

The following illustration shows the chart view of the Sales History Analyzer task. 
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Using the Business Insights Explorer 
 

 
Purpose 

Business Insights Explorer allows you to navigate through data, preview and drill 

down into related data for the selected data row, and customize and save filter 

settings for future use. You can also use the Business Insights Explorer to perform 

the following functions: 

• Display the data set in a Data View grid. 

• Refine and save customized data sets using filter tools. 

• Save multiple settings for each Explorer data view. 

• Add columns to or remove columns from the Explorer data view. 

• Group or subtotal data directly in the Data View grid. 

• Print the Data View grid information. 

• Port the data in the Data View grid to Business Insights Reporter. 

• Export the data to Microsoft® Excel®, Microsoft® Word®, PDF, or the eXtensible 
Markup Language (XML) formats. 

 

Accessing the Business Insights Explorer 

 
Overview 

There are three ways to access Business Insights Explorer, depending on your 

workflow needs. You can also access a Business Insights Explorer task directly from a 

window in the software or from the Tasks pane located on the Desktop. 

Note: Many inquiry tasks have been replaced by Business Insights Explorer. 

For more information on the inquiry tasks that have been replaced with 

Business Insights Explorer, see Business Insights Explorer FAQs in the Help 

system. 
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Procedure 

To access Business Insights Explorer from the software: 

1 In any window in the software, right-click the field that has the Business 

Insights Explorer feature available. 

2 On the right-click menu, select Explore, or select Drill Into, select a data set, 

and then select the filter setting name. 

Note: If no customized filter settings have been saved, Standard is the only 

filter that displays. 

3 The Business Insights Explorer window appears with the selected data set and 

filter in view. 

To access Business Insights Explorer from the Business Insights task group in the 

Desktop: 

1 In the Desktop, on the Tasks pane, click the Business Insights task group. 

2 In the Business Insights folder, expand the Explore folder. 

3 Double-click an Explore task. The Business Insights Explorer window appears 

with the data set for the selected task in view. 

To access Business Insights Explorer from a module task group in the Desktop: 

1 In the Desktop, on the Tasks pane, click the task group for any module that has 

the Business Insights Explorer feature available. 

2 In the module folder, expand the Insights folder. 

3 In the Insights folder, expand the Explore folder. 

4 Double-click an Explore task. The Business Insights Explorer window appears 

with the data set for the selected task in view. 
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Example 

The illustration below shows the Data View grid for the Explore Customer task. 

 

 
 

More information 

For more information, see the Help system. 
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Using the Business Insights 
Dashboard 

 

 
Purpose 

Business Insights Dashboard includes a series of key business data components (also 

referred to as Web Parts) that generate summary information and charts from your 

financial information. These components appear in the user’s Web browser and can 

be customized. This Web site provides executives with the ability to view and 

customize key business data for a selected company. You can also use the Dashboard 

Web site to view Business Insights Explorer data, as well as set links to commonly 

used sites. 

Business Insights Dashboard requires ASP.NET and AJAX extensions, both of which 

are installed automatically if your system currently does not have these installed. 

Business Insights Dashboard requires Windows authentication and cannot be 

configured for anonymous access. To access the Business Insights Dashboard, a 

system administrator needs to set up the Web site for executive access. For more 

information, refer to the Installation and System Configuration Guide. 

To learn more about using the Business Insights Dashboard, access the Business 

Insights Dashboard tutorials by clicking Tutorials on the Sage 500 ERP Desktop Home 

pane. 

 

Accessing the Business Insights Dashboard 

 
Procedure 

To access Business Insights Dashboard: 

1 Open a Web browser window. 

2 At the Address field, type the Web address for the Business Insights Dashboard. 

For example, http://www.mycompany.com/BusinessInsightsDashboard 

http://www.mycompany.com/BusinessInsightsDashboard
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The illustration below displays the Business Insights Dashboard: 

 

 

More information 

For more information, refer to the Business Insights Dashboard Guide. 
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Batch Processing 
You can process transactions in batches. The Batch Processing 

feature allows multiple users to enter transactions at the same 

time using unique batch numbers. One batch can contain either a 

single transaction or hundreds of transactions. 
 

One advantage to batch processing is the ability to print the 

registers, review the reports, and make corrections before 

updating the modules. 

This chapter describes how to set up batches, enter batch 

information, and the options for posting. 

In this chapter 

Setting Up Batch Options ................................................................................ 106 

Entering Batch Information ........................................................................... 107 

Posting Batches ...................................................................................................... 111 
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Setting Up Batch Options 
 

 
Setup options 

You can select various batch-related settings in your module's setup options task. For 

example: 

• Allow the creation of private batches, which limits access to a batch. 

• Enter batch override segments for general ledger accounts. 
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Entering Batch Information 
 

 
Purpose 

Use batch entry windows to create batches, enter additional data in existing batches, 

print batch registers, and post batches. For example, Accounts Payable has the 

following batch processing tasks: 

• Process Vouchers, where you enter invoice, credit memo, and debit memo 
information. 

• Process Invoices for Payment, where you select which invoices to pay and print 
the checks for these invoices. 

• Process Manual Checks, where you record information for checks that you 
wrote manually. You can also print manual checks using the Quick Print 
feature. 

• Apply Payments and Memos, where you apply previously posted unapplied 
payments, credit memos, and debit memos to open vouchers or memos. 

• Post AP Batches, where you can select, print, and post multiple batches. This 
task also gives you an overview of the status and totals of all unposted batches 
in your payables system. 

• Process Settlements, where you generate and enter settlements of Accounts 
Payable vouchers and Accounts Receivable invoices, print settlement reports, 
and post registers. 

 

A batch entry window appears when you select these tasks. 
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Entering information 

To enter information, create or reopen a batch in a batch entry window; this is the 

first window that appears in a batch processing task. You can then enter information 

for individual transactions. For example, you might enter 20 invoices in Accounts 

Payable Process Vouchers. When you exit the data entry window, the batch entry 

window appears again so that you can verify batch totals. 
 

 

Batch control amounts 

The batch control amount must equal the total of all transactions in the batch. If the 

batch total is negative, due to debit memos, the batch control amount must also be 

negative. If the batch is out of balance, the variance amount is displayed in the batch 

entry window and restricts posting. 

Tip: You can optionally enter a control amount to double-check data entry 

totals to a separate adding machine tape result. 
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Unposted batch statuses 

For each batch, the current status of the batch appears in the batch entry window. 

The status for any unposted batch can be one of the following: 

• In Use 

► Indicates another user is currently accessing the batch. 

► As soon as you generate or begin to work in a batch, its status 

automatically changes to In Use. 

► Additional users can still open the batch, unless it is marked as private. 

• On Hold 

► Indicates a user selected the Hold check box in the batch entry window for 

the batch. 

► You cannot post a batch that is on hold. 

• Out of Balance 

► Indicates financial amounts in the batch are not in balance with the 

control amount. 

► You must correct the balance before you can post the batch. 

► An Out of Balance status applies only if you enter an amount in the 

Control Amt field on the batch entry window. 

• Balanced 

► Indicates transactions in the batch are in balance, and the batch is not in 

use. 

• Posting 

► Indicates the batch is currently being posted. This status displays only 

during posting. 

► After posting, the batch no longer appears in the list in the batch entry 

window. 
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• Interrupted 

► Indicates that during the posting process, an unrecoverable error occurred 

(for example, a power failure). 

► No general ledger account balances are updated on an interrupted batch. 
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Posting Batches 
 

 
Purpose 

The batch posting process summarizes and applies batch amounts to specified 

general ledger accounts. You can post a single batch in a batch entry window, such 

as Process Vouchers, or post multiple batches using a Post Batches window, such as 

Post AP Batches. When you are ready to post multiple batches, you can sort batch 

information by batch number or posting date by clicking the applicable column; or 

you can display only those batches with a status of Balanced. 

Note: Only balanced batches can be posted. 

 

Verifying batch information 

Before posting batches, verify batch information in one of the following ways: 

• Review totals information in the batch entry window. 

• Print the register for the task and review it. 
 

You can then make corrections, print, and review the register before beginning the 

actual posting. 
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Posting options 

When you click Register/Post in a batch processing task, a window similar to the 

following appears. Use this task to select additional options, such as the number of 

registers to print and register format. 

The following printing and posting options are also available: 

• Print and then post 

• Print and then prompt for post 

• Print and do not post 

• Preview only 

• Post only 
 

 

Posting to a future period 

To post transactions to a future accounting period, enter the future period date as 

the posting date in the batch entry window. 
 

The posting date is used to post transactions and check them against the current 

period, which is defined in the module's setup options. 
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Posting to a closed period 

To post to a closed fiscal period, you must reopen the period in both General Ledger 

and the module from which you are posting. 

 

Overriding account number segments 

You may want to track certain expenses by department or region—assuming your 

general ledger account structure includes validated segments for these categories. 

However your general ledger account is structured, the concept is the same. The 

batch override option gives you the flexibility to easily track and report 

departmental or similar subcategories of expenses. 

Note: You cannot select the same override segment for vendor class and 

batch. 
 

If, for example, you are tracking departmental expenses, in Set Up AP Options, you 

define the override option for the department segment of the general ledger account. 

When you subsequently enter invoices, you can select the department from a 

Lookup window in the batch entry window. The department code then overrides the 

default account segment for all transactions in the batch. 

 

Additional information 

For additional information on account segment overrides, see the Help system. 

 

Invalid accounts 

The system handles amounts for invalid accounts in the following ways: 

• Invalid accounts are detected during data entry. Accounts are also verified 
during pre-posting processing. You cannot post a batch with invalid general 
ledger account information. 

• If you have enabled a batch or class override for a general ledger account 
number segment, and you have enabled the allow addition of new accounts 
feature, a new account number can be created. If the override fails, you receive 
a warning, and the system reverts to the original account. 
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• Invalid accounts are noted in the printed error log. You can either create an 

additional account in Common Information Maintain Accounts, or correct the 
voucher or check information with the correct account. 
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Generating Reports 
Sage 500 ERP includes sophisticated reporting capabilities that 

allow you to produce numerous reports and lists. Reporting 

features can assist you in managing and planning your business. 

This chapter describes the different report types and features, and 

indicates how to print, preview, defer, and customize Sage 500 

ERP reports. 

In this chapter 

Reporting Features .............................................................................................. 116 

Report Types ........................................................................................................... 117 

Standard Report Elements .............................................................................. 119 

Generating Reports and Lists ...................................................................... 121 

Previewing Reports ............................................................................................. 124 

Deferred Printing .................................................................................................. 126 

Customizing Reports ........................................................................................ 128 
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Reporting Features 
 

 
Purpose 

Sage 500 ERP reporting features enable you to: 

• Specify the content and format of reports. 

• Preview a report on screen before printing a hard copy or sending it to a file. 

• Defer reports to a print queue to print at a later time. 

• Define multiple report settings for the same report, and save each under a 
different name. This allows you to create several versions of the same report 
and to quickly and routinely print them. 

• Save report settings for future use. 

• Print lists containing data and system settings from many of the maintenance 
tasks. 

• Change report fonts, colors, and other format features within Sage 500 ERP. 

• Create and customize reports and forms using Crystal Reports for Sage 500 ERP. 

 

Supported printers 

Sage 500 ERP supports only laser printers. You cannot use dot-matrix or ink-jet 

printers to print Sage 500 ERP reports. 



Generating Reports 

Getting Started  117 

 

 

 

Report Types 
 

 
Purpose 

Reports provide you with reference information, transaction records, and a variety 

of analytical assessment tools. There are four report types: 

• Reference reports (lists) 

• Audit reports 

• Analysis reports 

• Financial activity reports 

 

Reference reports (lists) 

Reference information is available in lists that include system settings and 

enumerations of data groups. Lists allow you to verify the organization of the system 

and review data in the database. Lists are accessed primarily by clicking the Print 

button in maintenance tasks. The System Manager User List is an example of a 

reference report. 

 

Audit reports 

As you add, change, or delete records, Sage 500 ERP stores this information. Registers 

are preposting reports that allow you to verify transactions before you post them. 

Most registers can be viewed in summary or detail form. You can also generate 

reports to check information on posted transaction activity. 

 

Analysis reports 

Analysis reports help you analyze activity that occurs within the system, such as 

aging and statistical summaries and comparisons or current and closed accounting 

periods. The System Manager System Activity Log is an example of an analysis 

report. 
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Financial activity reports 

Financial reports provide a picture of financial activity over a selected period of time 

and your current standing. These reports allow you to review expense totals and 

outstanding invoices, plan for future cash needs, and track information required for 

governmental reporting. 
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Standard Report Elements 
 

 
Report elements 

Reports are preformatted to include the following standard elements. 
 

Report section 

content 

Page Header 
Company bar 

Report title 
Report subtitle 
Report message 
field (optional) 

 
Data included 

 
Company name 

 

General report title 
Specific report title 
User-entered description of sort 
and/or selection criteria (if any) for 
report data (optional) 

Report Body All report data 

Report Summary 

User ID 
Selection criteria 
Sort criteria 

 

Page Footer 
Run date/time 

Business date 

The person who generated the report 
Conditions for data selection 
Key fields designated for ordering data 
(last page of the report—not shown) 

 

Date and time derived from the 
operating environment 

 
Date derived from System Manager 

You can change the appearance of these elements as shown in Changing Report 

Formats on page 128. 

 

Report detail 

The Help system provides module-specific report explanations and samples. 
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Example report 

Following is a Sage 500 ERP report sample. 

 
Report Message 

 
 

 

Header: 

Company Name 

Report Title/Subtitle 

Purchase Order 

Options List 

 
 
 

 
This is where your text would be if you typed a 

message in the Message text box for a summary 

or detailed list. 

 
 

General 

Current AP Fiscal Period 

Posting 

6  Post GL Transactions 

 

Yes 

Current AP Fiscal Year 2020 Posting Register Format Detail 

Allow Private Batch No  Accounts 

Warn for Duplicate Purchases Yes Drop Ship 4015-00-00-00 

Print Purchase Orders 

Track Deleted Purchase Orders 

Default Cost at Purchase Order Entry 

Yes  Purchases Clearing 

Yes  Purchase Price Variance 

Yes 

2001-00-00-00 

4570-00-00-00 

Use Same PO Num for Blankets Yes Account Override Segments 

Use Blanket Release Num Yes  Vendor Class 

 

 

Report Body 

Activate Change Order Processing 

Check Vendor Credit Limit 

Integrate with AP 

Integrate With IM 

Track Sales Tax on Purchases 

 
Invoicing 

Invoice Complete 

Blind Invoicing 

 
Data Retention 

Purchase Orders 

No 

Yes 

Yes 

Yes 

Yes 

 
 

Yes 

No 

 

24 Months 

Batch 

Department 

 
Post in Detail 

Accounts/Payable 

Freight Charges 

Purchases/Expenses 

Sales Tax 

Discount Earned/Lost 

Purchase Price Variance 

Purchases Clearing 

Department 

 

 

 
Yes 

Yes 

Yes 

Yes 

Yes 

No 

No 

Requisitions 

Rcvr Retnt 

24 Months 

24 Months 

Apply Dept Override 

Freight Charges No 

Purchases/Expenses No 

Matching 

Match Receipts to PO 

Match Invoices to PO 

Purchase Order Default 

 
Yes 

Yes 

five 

Sales Tax No 

 
Apply Class Override 

Freight Charges No 

Purchase Order Line Item Default 

 
Control Characters 

Change Orders 

Release Num 

five 

 
 

C 

R 

Purchases/Expenses 

Sales Tax 

 
Apply Batch Override 

Freight Charges 

Purchases/Expenses 

No 

No 

 
 

Yes 

Yes 

Receiving 

Close Entire PO on First Receipt 

Close PO Line on First Receipt 

Sales Tax Yes 

No  Discount Earned/Lost Yes 

Yes 

Receive Complete 

Default Receipt Days Early 

Yes 

0 

Default Receiving Address 

Systems of America 

Blind Receiving 

Receiving Ticket Method 

Receiver Item Volume Update 

Receiver Item Weight Update 

Off 165 Pacific Highway 

Expected Items Malibu, CA 90263 

(none) 

(none) 

 

 

 
 

Footer: 

Run/Business Dates 

Run Date: 

Business Date: 

6/1/2020 

6/5/2020 

11:43:59 AM Page 1  

Systems of America 
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Generating Reports and Lists 
 

 
Overview 

Each module provides a Reports menu that contains that module's report options. 

Additional lists can be generated from within tasks on the Maintenance menu. 

 

Common printing options 

Task report windows display common printing options, which are shown in the 

following example. 

 
 
 
 
 

Print 

 
 

 
Preview 

Deferred Print 
 

Save report settings 

for future use. 

 
Select to print the report 

settings on the last page 

of the report. 

 

The IDs of report  

settings that you save 

appear at this field. 

 

 

Sort and selection criteria 

Most report setup windows have two tabs that are used to specify sort and selection 

criteria: 

• Main 

• Options 
 

The selection criteria and sort order define the information that appears on the 

report. 
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Multiple print settings 

You can define several print settings for the same report and save each setting with a 

different name. This allows you to create several versions of the same report that can 

be printed quickly. 

 

Using the Main tab 

The Main tab is used to define the sort and selection criteria for the report. Multiple 

sort and selection criteria can be defined on one report. 
 

The available information depends on the type of report you are printing. For 

example, Accounts Receivable reports include sort options for customers and 

customer classes. 

Columns determine the 

order of items on the 

report, if subtotals are 

added, and where to 

insert page breaks.   

 

 
Determines the records 

that appear on the report, 

such as Is equal to, Is 

greater than, and All. 

 
 

Right-click a field and 

select Insert Line for 

additional selection criteria. 

Note: To speed up searches, use the "Is equal to" or the "Begins with" filter 

type instead of the "Contains" option. 

 

Using the Options tab 

The Options tab is used to determine the overall report format and is generally 

report-specific. Available options vary, depending on the type of report. 

Note: Not all reports have an Options tab. 
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Examples of options include: 

• Detail or summary format 

• Date criteria 

• Message field contents 
 
 
 
 
 
 
 
 
 
 
 

Messages entered   

here print in the 

header of the report. 
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Previewing Reports 
 

 
Purpose 

Use the Preview feature to display a report on your screen. If the report does not 

require modification, you can either send the report to a printer, export it in your 

choice of file formats, or e-mail it to another user. 
 

Export 

Print 

Group Tree 

Zoom 

 

Search for specific 

information in a report or list. 

 
Items in the Group 

Tree window reflect 

sort options with the 

Subtotal check box 

selected on the Main 

tab in the report 

setup window. The 

Group Tree window 

can also contain 

additional system- 

defined levels. 

 
 
 
 
 

 

Preview features 

Additional preview features: 

• Using the toolbar at the top of the preview window, scroll through the report 
pages and change the view magnification. 

• Export in several formats, including Text, Crystal Reports, Excel, and Microsoft 
Word. 
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• Export information to a file or an e-mail message. 

• Group Tree window information can be grouped by subtotaled sort options. 

• As you select items in the Group Tree window, the corresponding information 
displays automatically in the Preview window. 
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Deferred Printing 
 

 
Overview 

You can postpone printing a report and store it as a file to print at a later time. The 

Deferred Printing task in the System Manager Tools menu is then used to select and 

print the stored report. This feature allows you to create multiple reports from 

various modules and print them all at the same time. 

 

Deferring a report 
1 Select the appropriate printer for the report you want to defer. (The destination 

printer cannot be changed when printing the report in System Manager 

Deferred Printing.) 

2 Click the Defer button on the report setup window. The Create Deferred Print 

File window appears. 
 

 

 

3 Enter a file name, or accept the file name that automatically defaults to the 

report name. 

4 Click Save to create the file. The report is automatically saved in Crystal 

Reports file format and cannot be changed. 

5 Close the report setup window. 
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Printing a deferred report 

Select System Manager Tools menu > Deferred Printing. The Deferred Printing 

window appears, which includes: 

• The module from which the report originated 

• Title, date, and time deferred 

• User ID 

• Destination printer 
 
 
 
 
 
 

Only the Copies 

and Purge 

columns can be 

changed on this 

window. 

 

1 To automatically delete the report after printing, select the Purge check box; 

otherwise, the report remains in the Deferred Printing window until you delete 

it manually. 

2 Enter the number of copies to print. 

3 Click the Print button to print the report, or click the Preview button to 

preview the report. 



Generating Reports 

Getting Started  128 

 

 

 

Customizing Reports 
 

 
Overview 

You can customize reports using Maintain Report Formats in the System Manager 

module. 

 

Changing Report Formats 

 
Overview 

You can change format features of reports. These include changing the font, content, 

and format of headers and footers. Format changes can be applied to all companies 

within a database, or different formats can be used for individual companies. The 

format changes you make will apply to all reports for a company regardless of who 

generates the report. 



Generating Reports 

Getting Started  129 

 

 

 

Using the Maintain Report Format form 

Select System Manager Maintenance menu > Maintain Report Format. The Maintain 

Report Format window appears. 
 

 
Use the tabs on the left to set the format of a section of a report. You can also click a 

section of the preview to switch to the appropriate tab. Changes you make to the 

format appear in the preview. 
 

When you have completed changing report formats, click the Save button. The 

changes appear the next time you run a report. 

Note: If a report is open or in progress when you change the report format, 

you can apply the format changes by rerunning the report. 

 

Companies and format changes 

The Company field enables you to apply changes to all companies or individual 

companies. 
 

If you select a company in the Company field, the format changes apply only to that 

company. You can make different settings for each company. 
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If you select (All), the format changes you make become the default for all 

companies. You can still make settings for individual companies. 

For example, if you wanted the text for the company bar to be centered and have a 

caption of "Company: " and each company to have a different colored company bar, 

do the following: 

• For (All), set the alignment to center and type "Company: " as the caption. 

• For each company, set the company bar color. 

 

Default settings 

The Default setting for each option enables you to revert the format as follows: 

• For a company, Default reverts to the format of (All), if a custom setting was 
made. If there is no custom setting, the format in the report definition is used. 

• For (All), Default reverts to the format in the report definition. 

 

Fonts 

Sage 500 ERP reports use the fonts on a user's workstation. When you select fonts for 

a report, select a font that all users have. If you select a font that is not on a user's 

workstation, Arial is substituted for it. 

 

Clearing format changes 

To clear all the formats for a company, click Delete. You are prompted to confirm the 

deletion. 
 

If you select (All) and click Delete, the settings are cleared as defaults for all 

companies. If you set up settings that are specific for a company, they are not 

cleared. To use the previous example, clearing (All) resets the alignment and caption 

to the format in the report definition, but keeps the company bar color settings you 

made for each company. 
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Designing Reports with Crystal Reports 

 
Overview 

Sage 500 ERP comes with the powerful report generator, Crystal Reports, which 

includes templates that allow you to produce professional reports. 

 

Features 

Crystal Reports has the following features: 

• Use a predefined report template or design your own template. 

• Include information from one database or from several data sources, do 
extensive calculations, and merge text with data. 

• Produce mailing labels and form letters that draw from your data sources. 

• Modify Sage 500 ERP reports, lists, and analyses. 

 

Crystal Reports documentation 

Crystal Reports for Sage 500 ERP comes with documentation that guides you through 

its installation. For instructions on using Crystal Reports to redesign report 

templates, refer to Crystal Reports' documentation and the Help system. 
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Using the Help System 
The Sage 500 ERP Help system provides information and 

assistance in all aspects of the software, including system basics, 

step-by-step instructions for individual tasks, and field-specific 

help. The Help also includes module PDFs that describe the tasks 

you can access from the Desktop. 

In this chapter 

Types of Help .......................................................................................................... 133 

Help Center .............................................................................................................. 137 

Viewing the Contents Tab ............................................................................ 139 

Viewing and Printing the Module PDFs .............................................. 140 

Viewing the Index Tab .................................................................................... 141 

Understanding a Help Topic ........................................................................ 142 

Using the Tutorial ............................................................................................... 143 

Quick Reference ..................................................................................................... 145 
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Types of Help 
 

 
Introduction 

The Help system includes the following types of Help: 

• Overview Help 

• Procedure (How Do I...) Help 

• F1 Field-Level Help 

 

Overview Help 

 
Overview 

The Overview Help provides a functional overview of each task. Links to procedures 

and related topics are also provided in Overview Help. 
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Accessing 

To access Overview Help, click the Help button (or press CTRL+H) from any task 

window. 

 

 

Procedure Help 

 
Purpose 

Procedure Help provides step-by-step instructions for completing a specific task. 
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Accessing 

Access Procedure Help from the How Do I... links in the overview topic. 
 
 
 
 
 
 

 
Click a Shortcut button   

to open the task. This 

allows you to complete 

a task while following 

the step-by-step 

instructions in the 

Procedure Help 

window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

F1 Field-Level Help 

 
Purpose 

F1 Field-Level Help provides information that is specific to a selected field, button, or 

tab. 
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Accessing 

Access field-level Help by pressing F1 at each field or by right-clicking and selecting 

What’s This?. 

 

Example 

The following window shows an example of F1 Field-Level Help for the Status field. 
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Help Center 
 

 
Introduction 

The Help Center provides links to the documents, Help system, online resources, 

and technical support information available. 

 

Ways to access 
Access the Help Center three ways: 

• On the Desktop, select Help menu > Help Center 

• Click the Help Center link on the Desktop Resources page 

• Click the Help Center button on the docked Desktop toolbar 

 

Content 

The Help Center provides access to the following sources of information: 

• Installation guide 

• Help system 

• Reference information, including sample reports 

• Module PDFs 

• Technical support 
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Example 

The following window shows the Help Center options. 
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Viewing the Contents Tab 

 
Purpose 

Use the Contents Tab to access the table of contents for the Help system. The 

following illustration explains the common features of the Contents tab. 

 
When you first   

access Help, 

the Contents 

tab is hidden. 

Click Show to 

use the 

Contents tab. 

 
 
 
 
 
 
 
 
 
 

 

The Contents tab 

displays Help 

topics organized 

by key subjects. 
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Viewing and Printing the Module PDFs 

 
Purpose 

You can view and print PDF documents from the Help system that contain task 

information for each module. Use the links located under the Module PDFs book on 

the Contents tab to access and print the PDF files for all modules. 

 

Accessing 

Use the links located under the Module PDFs book on the Contents tab to access and 

print the PDF files for all modules. 
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Viewing the Index Tab 

 
Accessing 

Use the Index Tab to search for specific words and phrases. Each Help topic has 

keywords associated with it. You can search for a topic in the Index by entering 

keywords. The following illustration explains the common features of the Index tab. 
 

Select a topic, and then click 

Display to view the topic. Or, 

double-click a topic in the list 

box to view it. 
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Understanding a Help Topic 

 
Purpose 

A Help topic may contain procedural information, overview information, or 

information about a particular feature. 
 

Click FAQs & 

Troubleshooting 

to view frequently 

asked questions 

grouped in 

categories, such 

as Budgets or 

Checks. 

 
This section lists   

items that must be 

accomplished 

before performing 

this procedure, or 

special conditions 

that may affect the 

result of this 

procedure. 

 
 
 
 
 
 
 
 

Click the +/- 

graphic link to 

expand or 

collapse all 

dynamic drop 

down links in 

this topic. 
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Using the Tutorial 

 

 
Select Help > Tutorial to take a quick tour through the software. The tutorial is a 

multimedia introduction to the software's basic concepts and features. Use it to 

become familiar with basic concepts, such as navigating the software, customizing 

your Desktop, and printing reports. 

Note: You can also access the tutorial from the Desktop Tutorials page. 
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Tutorial topics contain short movies that demonstrate visual tasks 

in the software. To play the movie, click the Forward button. You 

can stop and rewind the movie at any time. You can also click and 

drag the bar that appears to the right of the Forward button to view 

the movie forward or backward at your own pace. 

To begin, 

click a topic. 



Using the Help System 

Getting Started  145 

 

 

 

Quick Reference 
 

 
Help features 

The following table provides a quick reference to the Help system components and 

features. 

Graphic Component Located Description/How Accessed 

Overview 
Help and 
Help Center 

Most windows 
and Desktop 

On windows, provides a functional 
description of the task and links to 
related information. For more 
information, see Overview Help on 
page 133. 

On the Desktop, opens the Help Center. 
For more information, see Help Center 
on page 137. 

 

Sage 500 
ERP task 
shortcut 

Task Help Opens the Sage 500 ERP task, allowing 
you to complete a task as you follow 
the step-by-step instructions in the Task 
window. 
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Glossary 
 
 

The glossary is applicable to all modules. 

 

absolute 

pricing 

Pricing based on a fixed dollar amount for each price level. 

 

access 

permissions 

The right given to display, add, change, or delete information. You 
give this right when you assign the user a password or assign the 
user to a security group. Permissions include Excluded, Display 
Only, Normal, and Supervisory for tasks, and Yes and No for 
security events. 

 

account A type of record that contains business transactions affecting the 
same item, such as a record containing all charges to Cash or 
Telephone Expenses. 

 

account 

category 

A group of accounts that are treated similarly for financial 
reporting. The five basic account categories are assets, liabilities, 
capital, revenues, and expenses. 

 

account group A range of account numbers defined during account setup that 
provides the basis for the subtotal on financial reports. 

 

account 

number 

An account's identifying number. 
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account 

segment 

 
A group of numbers or characters within an account number that 
carries specific meaning for the account. For example, the first five 
numbers might identify the account category as asset. 

 

account type Account categories are broken down into smaller groups called 
account types. For example, for the category asset, you can have 
the account types cash, inventory, and prepaid expenses. 

 

accounting 

cycle 

The series of steps performed during each accounting period to 
classify, record, and summarize financial data for a business and 
produce the necessary financial information. 

 

accounting 

equation 

Assets = Liabilities + Owners' Equity. The relationship between the 
worth of a business (assets) and the claims to that worth held by 
creditors (liabilities) and owners (equity). 

 

accounts 

payable 

Amounts owed to others (a liability) for goods or services 
purchased on credit. 

 

accounts 

receivable 

Amounts owed to a business (an asset), usually by customers who 
purchased goods or services on credit. 

 

acknowledge- 

ment 

A formal declaration of the sales order by a customer. 
Acknowledge dates are required to change the status of a sales 
order to Open. 

 

actual costs The total of all costs incurred on a job. Sage 500 ERP calculates 
this figure by totalling all charges relating to a job. 

 
adjustments In the General Ledger module, journal entries required at the end 

of an accounting period to record an internal transaction and to 
bring the ledger up to date. Adjustments can also be made to 
invoices with credit or debit memos and to inventory quantities. 
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aging The act of analyzing accounts receivable or payable according to 
how long they have been outstanding. The invoice date is 
generally used as the base point for determining age. Many 
businesses age receivables and payables in 30-day increments. 

 
allocations Amounts distributed from one or more source accounts to one or 

more destination accounts. 

 
asset A property or economic resource owned by a company. Typically, 

assets include cash, marketable securities, accounts receivable, 
inventory, land, buildings, equipment, and prepaid expenses. 

 
audit trail A method of tracking transactions through each sequence of their 

history so that all financial information can be traced. Certain 
reports, such as AR Trial Balance and AP Trial Balance, should be 
kept as part of your permanent business record for the audit trail. 

 

available 

quantity 

The quantity of an item that is deemed to be available for sale or 
use. This is the quantity on hand adjusted by the quantity on 
order. Users can control whether quantities on sales orders, 
purchase orders, or transfer orders affect the quantity available. 

 

back orders Orders placed by customers that have been at least partially 
shipped, but are temporarily unfillable due to stock shortages. See 
committed. 

 
bad debt An uncollectable account receivable. 

 

balance 

forward 

In the Accounts Receivable module, a method of computing 
customers' statements that carries forward the previous month's 
balance in total. See open item method. 

 

balance sheet In the General Ledger module, a standard financial report that 
takes a snapshot of your business as of a specific date, showing a 
company's assets, liabilities, and capital. 
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base pricing A pricing method that uses a base price (a standard amount on 
which you base the actual part prices) and percentages based on 
that price. 

 
bid An estimate of the steps, price, and schedule to complete a job. 

Bids are the first stage in job completion. Customers often request 
one or more bids (estimates) before giving their approval to begin 
a job. 

 
bill of lading A receipt for a freight company displaying the shipment and 

delivery address. 

 
billings The amount for which a customer is invoiced for a job. Billings are 

based on the established price of the job. 

 
bin A location in your warehouse for storing inventory items. 

 
bin ticket A parts list helpful in returning parts to inventory after 

disassembling an assembled kit. 

 
blanket order A shortcut method of ordering or selling large quantities of items, 

and receiving or delivering those items over a period of time. 
Blanket orders can be contract or noncontract. 

 
blind picking Requires that you manually enter the picked amount of an item 

on a pick list. 
 

blind 

receiving 

Requires that you manually enter the picked amount of an item 
on a receipt. 

 

book quantity The quantity of an item you have recorded in your books as being 
on hand. A physical inventory count may reveal shortages or 
overages. 

 

build-to-order 

kit 

An item containing many components that are bundled into a 
single inventory item at the time of order. 
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business date The default transaction and posting date. Appears as a default on 
many reports and screens. You can change this date for reporting 
purposes. Defined in the System Manager module. 

 
capital See owner's equity. 

 
caution box A box that appears when you enter data incorrectly or when Sage 

500 ERP wants to bring a point to your attention. Caution boxes 
can contain error messages, notes, and warnings. 

 
change order The document created when a modification is made to an existing 

purchase order or sales order. 

 
charges The actual costs incurred during each phase of a job. 

 

chart of 

accounts 

In the General Ledger module, a list of all of a business' accounts, 
usually grouped by account type. 

 

close The act of advancing the system to the next accounting period. 
Each module has specific close functions. For example, a close in 
the General Ledger module posts all earnings for the month to 
year-to-date earnings. 

 
committed Items that have been ordered by your customers, but have not yet 

been fully or partially invoiced. 

You can also commit sales order shipments, transfer shipments, 
and customer returns if you want to perform all of the functions 
of posting except the update to the general ledger. Inventory 
quantities and cost tiers are updated, pending invoices and credit 
memos are created, general ledger accounts and entries are 
determined, and the Inventory Management module history is 
updated. See back orders. 

 

commodity 

codes 

A means to classify items for tax and other regulatory purposes. 

 

company ID A code that identifies a company's records. 
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completed The status of a job indicating that all charges have been made 
against the job. 

 
components Parts used to build a subassembly or finished item. 

 
controls Items that make up the Sage 500 ERP windows. Examples of 

controls include text boxes, option buttons, check boxes, window 
or dialog box titles, and toolbar buttons. 

 
cost method The method used for determining the cost of the inventory items. 

 

cost of 

carrying 

The overrhead costs incurred due to keeping items in inventory 
over a period of time (for example, warehouse rent, insurance, and 
shrinkage). 

 

cost of goods 

sold 

An account that tracks the costs of inventory sold. 

 

cost of 

ordering 

The costs associated with each purchase order, other than the 
vendor cost. 

 

cost tier The cost and pricing structure for items in a company. 

 
count card A printed card to facilitate the manual counting of inventory 

items. 

 
count cycle The period in which an item is included in a physical count. See 

physical inventory count. 

 
count item An item that has been selected to be physically counted. 

 
credit An entry that decreases an asset or expense account or increases a 

liability, capital, or revenue account. 
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credit memo  A method of decreasing a customer's liability to you or increasing 
your liability to a vendor. For example, a credit memo is issued if 
the vendor undercharged you for invoiced items. 

 

cross-rate 

derivation 

The method of using two sets of currencies with a common 
currency in each set to calculate the rate of exchange between the 
other two currencies. For example, you need the rate of exchange 
between the Hong Kong dollar and the Australian dollar and you 
do not maintain an exchange rate between the two currencies. 
You can calculate the rate if you have a rate between the US dollar 
and the Australian dollar and you have a rate between the US 
dollar and the Hong Kong dollar. 

 

current asset Assets that are cash or expected to be converted into cash within a 
one-year period. 

 

current 

liability 

Liabilities that will be due within a one-year period. 

 

custom field Field you can establish to further define and sort information in 
reports. 

 
customization See form customization. 
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customization 

level 

 
The set of attributes that determines whether a customization 
displays for a user. The customization level specifies user-, group-, 
and company-ID criteria that must be met for the customization 
to display. The heirarchy of customization levels is, from lowest to 
highest: 

1 Forms shipped with Sage 500 ERP (no customizations) 

2 Site-level (all users) 

3 Company-level (all users in a specific company) 

4 Group-level (all users that are members of a specific group 

as their default group) 

5 User-level (specific user) 

6 User- and company-level (specific user in a specific 

company) 

When a user opens a window that has customizations, the 
customization with the highest level for that user is activated. 

 

debit An entry that increases an asset or expense account; or decreases a 
liability, capital, or revenue account. 

 
debit memo A method of increasing a customer's liability to you or decreasing 

your liability to a vendor. For example, a debit memo is issued if 
the vendor overcharged you or you returned merchandise to the 
vendor. 

 
demand The projection of the usage of an item for a future period. 

 
department Used to set up contacts and ship-to addresses on blanket purchase 

orders, purchase orders, and requisitions. Departments consist of 
an address and a department. 

 
Desktop The user interface that appears when you start Sage 500 ERP. The 

Desktop is the starting point for all tasks. 

 
detail The detailed information (quantity, unit cost, unit price, and 

priority) assigned to a job code for a phase of a job. Job codes are 
used to break down the charges required to complete a phase. 



Glossary 

Getting Started  154 

 

 

 
 
 

discount A deduction from the invoice price of goods. An early payment 
discount is offered for payment made within a specified time 
frame. An invoice discount reduces the charges to the customer 
for a line item or the total invoice (such as for quantity purchases). 
You can take advantage of discounts offered by other vendors with 
the Accounts Payable module and offer discounts to your 
customers with the Accounts Receivable module. 

 
distribution The process of selling goods from a warehouse to a customer. 

 

double-entry 

accounting 

A system for recording transactions that requires the accounts to 
be in balance at all times, so that debits always equal credits. 

 

drill around Retrieving additional data of a greater detail for a specific entry 
(usually retrieves related data or transactions for a specific 
transaction). 

 
drill down Retrieving more detailed data directly related to a specific entry. 

 
drop ship Purchase order items that are shipped directly from the vendor to 

the customer. 

 
earnings The difference between revenues and expenses. 

 

emergency 

purchase 

order 

A recommended purchase order for a purchase product line that 
meets the vendor's target purchase requirements, but contains 
only those items that are in need of replenishment. 

 

EOQ The Economic Order Quantity. This is the most economical 
quantity of the part for you to buy based on factors such as 
quantity breaks you may get from the vendor, overhead, etc. 

 
equity The rights or financial claims of owners, stockholders, or creditors 

to the company assets. 

 
estimated cost The projected cost of a job based on the quantities of resources 

defined as job codes. 
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exchange rate The term used for the rate at which one currency can be 
exchanged for another. For example, one British pound may be 
equal to $1.50 USD. 

 
expenses The amount of assets consumed or services used in the process of 

earning revenues. 
 

expiration 

date 

The date on which a quote, lot, or price will no longer be 
honored. 

 

exposed 

objects 

Objects, such as properties and methods, that Sage 500 ERP allows 
you to access. See script. 

 

finance 

charge 

A charge assessed to an account because of past-due invoices. 

 

fiscal year A time span used for accounting that you can divide into distinct 
accounting periods. A fiscal year does not necessarily coincide 
with the calendar year. See period. 

 

form 

customization 

A collection of edits made to a form in Sage 500 ERP. See 
customization level. 

 

free on board 

(FOB) point 

The point at which the title of ownership for items ordered is 
transferred. The FOB point determines the tax schedule. For an 
origin FOB, the shipping warehouse's tax schedule is used. For a 
destination FOB, the customer location's tax schedule is used. 

 

freeze count A process that records the current inventory totals for use in a 
physical count. 

 
freight class A shipping classification that determines the amount to apply for 

the cost of shipping. 

 
grid Tables appearing in the bottom half of many task windows to 

simplify line entry with mouse and keyboard shortcuts. Grids 
contain column and row format. 
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gross profit The sales amount minus the cost of goods sold amount. 

 
hard override The act of manually removing a link from a voucher line to a 

purchase order line during matching. 
 

home 

currency 

The currency in which the company conducts business and 
reports their financial condition. 

 

immediate 

picking 

The act of gathering the items needed to fill a simple sales order in 
Process Sales Orders immediately after it is entered in Enter Sales 
Orders and Quotes. Orders with complex picking requirements 
must be processed in Create Pick List. 

 

in house A job set up for internal company use for tracking expenditures 
for projects such as product research and development, marketing 
campaigns, or office remodeling. In-house jobs do not have a 
price, and billings and payments cannot be posted against them. 

 
in progress A job status indicating that job-related transactions (change 

orders, charges, billings, credit/debit memos, and payments) can 
be processed. 

 

income 

statement 

A standard financial report that reflects sales, expenses, and the 
resulting net income or loss for a given period. 

 

inquiry A means of accessing stored information. 

 
inventory Material or items owned by a company that will be supplied to 

other companies or individuals. 

 
invoice An itemized statement of goods bought and sold; also called a bill. 

 
issues The process of relieving inventory (usually for internal purposes). 
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job codes Codes used to identify the different types of costs for a phase, 
including labor, materials, subcontracting, equipment, overhead, 
or miscellaneous items. 

 
journal The place where you originally record transactions. Detail or 

summary journal information is posted to the General Ledger 
module. 

 
journal entry A transaction recorded in a journal. 

 
kits Groups of parts, labor, miscellaneous charges, or comments that 

are often ordered together. 

 
lead time The number of days it takes to receive an item after generating a 

purchase order. 

 
liability A debt owed. These usually include accounts payable, notes 

payable, income taxes, and dividends paid to stockholders. 

 
limit tolerance An amount in your home currency that a customer can exceed its 

credit limit before issuing a warning. 

 
line pricing Pricing based on the method (Margin, Markup, or Base) you have 

entered. 

 
lookup A query tool to conduct information searches according to 

conditions you define. With Lookup, you can retrieve and insert 
data into the current field. The magnifying glass button appearing 
to the right of any field invokes Lookup. 

 
lot number A unique code that usually identifies a batch of an item for 

tracking and identification purposes. 

 
maintenance The act of adding, changing, or removing data. 
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matching The process of comparing the purchase order amount or quantity 
against the invoice amount or quantity. 

 

minimum 

purchase 

requirement 

A minimum order requirement for a purchase product line 
specified by a vendor. 

 

module An individual accounting system of Sage 500 ERP that handles a 
specific area of accounting, such as General Ledger or Accounts 
Payable. 

 

national 

account 

A grouping of customers into a two-level relationship, consisting 
of a top-level parent customer and an unlimited number of 
subsidiary customers assigned to the parent customer. A national 
account parent can be authorized to pay the invoices of the 
subsidiary. 

 

natural 

currency 

The currency in which a document is entered. 

 

Navigator A query tool to conduct information searches according to 
conditions you define. With Navigator, you can retrieve a 
complete record of information from any database linked to the 
current field. The flashlight button appearing next to any field 
invokes Navigator. 

 

noninventory 

item 

Items that are not part of your inventory, such as freight, sales tax, 
or consulting fees. 

 

nonstock item Items that are not part of your regular inventory. See noninventory 
item. 

 

offsetting 

account 

The account used in the General Ledger module to balance a 
transaction. 
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open item 

method 

 
In the Accounts Receivable module, a method of producing 
customer statements that lists prior month's invoices individually. 
See balance forward. 

 

open period The time span to which you are currently posting transactions. 

 
order point The quantity of an inventory part that, when reached, marks the 

point at which you wish to order more. 

 
owner's equity Assets minus liabilities. 

 
packing list A list of the items included in a shipment. 

 
partial receipt Created when not all of the items ordered are received. 

 

partial 

shipment 

Created when all of the items ordered are not shipped. 

 

password A security code word used to gain access to software and 
databases. Both the network and Sage 500 ERP have password 
protection. You must enter the correct password before you can 
access any of the tasks. Passwords are set up in the System 
Manager module. 

 

password 

access 

The tasks available to a particular password. 

 

path The location of a file in relation to a drive and directory. 

 
payables The money owed to vendors for goods and services purchased on 

credit. 

 
payment Money received from a customer to pay an outstanding debt. 

 
period A segment of a fiscal year. See fiscal year. 
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phases Phases are the steps involved in completing a job. A job must have 
at least one phase. A phase may include detail, in which case you 
can assign job codes to break down the charges required to 
complete the phase. 

 

physical 

inventory 

count 

The process of counting your inventory to compare actual 
quantities with the quantities you have recorded in your books. 

 

pick list A list used for gathering the components needed to assemble a 
subassembly. 

 
pick ticket A list used for gathering the items needed to fill an order. 

 
posting The act of applying transactions to general ledger accounts. 

 

preassembled 

kit 

Items that are combined to make a single inventory item. See 
build-to-order kit. 

 

preferred bin The favored location for an item within a warehouse. 

 
price sheets A list containing the base prices used when pricing customer sales 

orders. 

 
priority A whole number between 1 and 999 that you assign to job code 

line items. Priority is used to determine the order in which detail 
items appear on reports. More than one detail item in each phase 
can have the same priority. 

 

probability 

percentage 

The likelihood of a quote being converted to an order. 

 

product line A grouping of related items that can be analyzed for sales or 
purchasing purposes. 
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purchase 

order 

 
A document used for purchasing both inventory and 
noninventory items, which defines the quantities, prices, and 
vendors from which the items will be purchased. 

 

purchase 

product line 

A group of items that can be purchased together from the primary 
vendor with a cost benefit for higher quantities ordered. 

 

quantity on 

hand 

The quantity of a stocked product that is owned by the 
distributing company. This quantity is normally maintained “on  
the shelf” in the distributor's warehouse. 

 

quote An estimate of the price of goods or services, usually requested by 
a customer. See bids. 

 
rank The process of sorting and assigning percentages to items based on 

the cost of goods sold, gross margin, quantity sold, and hits. 
 

realized gain 

or loss 

(RGOL) 

The loss or gain due to changes in the exchange rate when a 
transaction is completed (paid) in a currency other than the 
currency of the company (home currency). RGOLs are included in 
the determination of net income. See unrealized gain or loss. 

 

receiver A statement that shows a shipment of goods. Also called a receipt. 
 

receiving 

ticket 

Used to record items received, quantity received, receipt unit of 
measure, and associated weight and volumes on receipt of goods. 

 

reconcile The method used to balance a bank account against a bank 
statement. 

 
record A collection of related items of information or “data elements,” 

such as customer or vendor information, stored together in a file. 
 

recurring 

journal entry 

In the General Ledger module, a type of transaction that needs to 
be posted on a regular basis, such as rent or depreciation. 
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replenishment The process of restocking items in a warehouse. 
 

replenishment 

source 

The means of restocking an inventory item; it can either be 
purchased or transferred from another warehouse, or assembled in 
the same warehouse. 

 

requested 

date 

The date by which an order is needed. 

 

requisition A formal request for goods or services to be purchased. 
Requisitions are not typically created to replenish normal 
inventory, and are not required to create a purchase order. 

 

retained 

earnings 

Earnings accrued from prior years' operations. In the General 
Ledger module, Sage 500 ERP automatically tracks year-to-date 
earnings for you and posts them to the retained earnings account 
at year end. 

 

returns Items that are returned to inventory. 

 
revaluation The process of computing the unrealized gain or loss. 

 
revenue Income produced by the company; also called sales. 

 
safety stock The quantity of an item that is maintained in the warehouse 

above the demand projection to avoid unforeseen stock-out. 

 
sales order A customer request for merchandise or services. 

 
script A collection of statements that performs calculations, modifies 

data on a form, or interacts with other desktop applications. Using 
the Customizer Forms Customization task, scripts are associated 
with controls (for example, custom toolbar buttons), so that the 
script runs when the user selects the control. 
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scrolling To move through text using scroll bars or arrow keys (up, down, 
left, or right) in order to see parts of the file or list that do not fit 
in the window. 

 
seasonal item Any category of a stocked item. 

 
security event Tasks, mostly overrides, predefined by Sage for which permission 

is defined in System Manager Maintain Security Groups. Events 
are application specific. Permission level is either Yes (user 
permitted to perform the security event) or No (permission 
denied). 

 
security group A group of users who have access to the same companies, menus, 

tasks, and events. Defined in System Manager Maintain Security 
Groups. 

 
serial number A unique code assigned to an item for tracking and identification 

purposes. 

 
ship label A label with a customer's name and address that a vendor attaches 

to a package. 

 
shipment The cargo that a vendor sends to a customer. 

 
shrinkage The loss of inventory items due to factors such as faulty 

manufacturing or deterioration, or theft during production, 
storage, or transit. 

 
soft override The act of allowing a voucher line causing a match failure to be 

posted without changes. 

 
source A code used to identify how a vendor acquired a customer. 

 
spot rate The exchange rate at the time of the transaction. Also known as 

the daily rate. 



Glossary 

Getting Started  164 

 

 

 
 
 

standard cost A cost stated in terms of the stocking unit of measure. 

 
subassembly An item listed as a part in your inventory that is made up of 

component parts. 
 

subsidiary 

company 

A company having its own set of accounts, but which combines 
its account balances with those of the parent company for 
reporting purposes. 

 

subcontract- 

ing 

Hiring a nonemployee or company to complete some portion of a 
job. 

 

substitute 

item 

A replacement for an ordered item that is unavailable. 

 

target 

purchase 

order 

A recommended purchase order for a purchase product line that 
meets the vendor's target purchase requirements. 

 

target 

purchase 

requirement 

A purchase requirement for a purchase product line specified by a 
vendor in order to get some cost benefit. 

 

task Any choice listed on a menu or found on the Desktop that allows 
the user to perform an activity. Tasks are predefined by the system 
and have permission levels defined in System Manager Maintain 
Security Groups. 

 
terms Payment terms on an invoice. For example, terms of 2/10, net 30 

means that a bill paid within 10 days receives a 2% discount; 
otherwise, the undiscounted amount must be paid within 30 days. 

 
third currency A currency that is neither the home currency nor the natural 

currency. 
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tolerance The degree to which a voucher quantity, cost, or receipt quantity 
can deviate from the purchase order quantity or cost. Tolerances 
also determine the action that results from a failure that falls 
within the specified allowances. 

 
transaction An entry made in any of the Sage 500 ERP modules that increases 

or decreases an account in the General Ledger module. 

 
trial balance The general ledger report that lists the balances of all accounts in 

the General Ledger module. Used to verify that all debits equal 
credits in the accounts. 

 

unit of 

measure 

The method by which an individual item is stocked, purchased, or 
sold. 

 

unrealized 

gain or loss 

When a transaction is completed (paid) in a currency other than 
the currency of the company (home currency), the loss or gain 
due to changes in the exchange rate is called a realized gain or 
loss. An unrealized gain or loss is the amount of the gain or loss if 
the transaction were completed at the current exchange rate. 

 

usage Total consumption of an item by the means of sale, transfer, or 
assembly. 

 
use tax Excise taxes taken for items purchased in one jurisdiction (for 

which you do not pay sales tax) and used in another jurisdiction 
(which obligates you to pay a use tax). 

 
vendor A company from which you purchase goods or services. 
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warehouse The location in which the inventory is physically located. 

 
wave picking Picking for a group of orders in one pick list. During wave picking, 

the picker makes one round of the warehouse and picks each item 
once for all orders requiring that item. In wave summary picking, 
the sorting and packing of items occurs after picking as a separate 
step. In wave detail picking, the sorting and packing of items can 
occur while picking is being performed. Wave picking is also 
referred to as group picking or batch picking. 

 
write-off The portion of a customer's unpaid invoice or billing balance that 

is forgiven. 

 
zone Groups or ranges of bins in a warehouse. Zones can correspond to 

how inventory is segregated in the warehouse by such factors as 
storage type, geographical area, product line, supplier, customer, 
or traffic pattern. Zones can be set up for warehouses only if the 
Warehouse Management module is activated. 
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Index 
A 
account numbers, searching for 59 
Activities menu 52 
Alerts, Sage 500 ERP 15 
analysis reports 117 
Analyze 67 
Analyzer 

creating filters 96 
purpose 93 
using the toolbar 95 
viewing data 95 

audit reports 117 
authentication options, logon 29 

 
 
 

 
Business Insights Dashboard 5, 25, 103 
Business Insights Explorer 100 
buttons, definitions 68 

C 
chart, creating in Business Insights 

Analyzer 99 
Client Configuration Utility, using 32 
common menus 51 
components, features 11, 13 
contacting Sage 9 
customization 

reports 128 
search window 61 

B 
batches 

entering information 108 
posting 111 
setup options 106 
statuses 109 

Business Insights 65 
analyze 67 
drill into 67 
explore 66 
manage 67 

Business Insights Analyzer 
accessing 93 
creating a chart 99 
creating a pivot table 98 
creating filters 96 
Data View grid 97 
using the toolbar 95 
viewing data 95 

D 
Data View grid 97 
dates, types used by Sage 500 ERP 91 
deferred printing 126 
Desktop 

components and navigation 37 
Help Center 137 
keyboard shortcuts 50 
locking 42 
moving and docking 40 
toolbar customization 46 
using 35 

drill into 67 

E 
explore 66 
Explorer bars 

customizing 43 
using 37 
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exporting grid data to template 84 

F 
filtering searches. See search filter 
filters, creating in Business Insights 

Analyzer 96 
financial activity reports 118 
function keys, definition 77 

G 
grids 

customizing columns in 80 
editing text in 79 
exporting to template 84 
overview 78 
populating 78 
printing and exporting from 82 
selecting report criteria in 87 
selecting rows in 81 
using keyboard shortcuts in 88 
using the mouse in 90 
working with lines in 82 

H 
Help 

features 145 
Help Center 137 
overview 133 
quick reference 145 

Task 134, 139, 142 
What’s This? 135 

I 
Installation and System Configuration 5 
invalid accounts, posting for 113 

K 
keyboard shortcuts 68, 74 

line entry grid 88 
setting 50 
system buttons 68, 74 

keys, function 77 

L 
lists, generating 121 
Lock Desktop 42 
logon 

and Client Configuration Utility 
setup 33 

authentication options 29 
SQL Server 30 

Lookup feature 54 

M 
Maintenance menu 51 
Manage 67 
Manufacturing 20 
menus, common 

Activities 52 
Maintenance 51 
Reports 52 
Tools 52 

module PDFs 6, 137 
modules, base system components 13 

N 
Navigator 54 

O 
Overview Help 133 

P 
pivot table, creating in Business Insights 

Analyzer 98 
posting 

batch status 109 
batches 111 
for invalid accounts 113 

preferences, setting user 53 
prerequisite knowledge 3 
previewing reports 124 
printing 

deferred 126 
grid information 82 
options, common 121 
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Q 
Quick Search 58 

R 
Record Filter, using 59 
reference reports (lists) 117 

release notes 4, 5 
reports 

analysis 117 
audit 117 
common printing options 121 
deferred printing 126 
designing with Crystal Reports 131 
features 116 
financial activity 118 
fonts 130 
format customization 128 
previewing 124 
printing options 121 
reference 117 
sample 120 
Sample Reports guide 5 
standard elements 119 
supported printers 116 
writers and viewers 24 

Reports menu 52 

S 
Sage, contacting 9 
sample reports 5 
search engine capabilities 56 
search features 

changing data search displays 61 
column customization 61 
filtering 58 
GL Account 64 
Lookup and Navigator 54 
overview 54 
Quick Search 58 
Record Filter 59 
searching for account numbers 59 
searching for data 56 

 
search features (continued) 

shortcut 60 
views 62 

search filter 
saving 60 
using 58 

Select grid 88 
shortcuts 

keyboard 88 
search 60 

Software Development Kit 6 
Installation guide 6 
reference documentation 7 

sources of information 
configuration and installation 5 
contacting Sage 9 
Help system 8 
introductory system and setup 4 
Software Development Kit 6 
support 9 
user guides 5 

SQL Server authentication 30 
support 9 
system buttons, definitions 68 

T 
Task Help 134, 139, 142 
Tasks, customizing 44 
Toolbars 

customizing 46 
description 39 

Tools menu 52 
tools, customization 25 
tutorial 143 

U 
user guides 

features of 5 
information provided 5 

user preferences, setting 53 

V 
views, search window 62 
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W 
What’s This? Help 135 


